
VisualAge Generator

Installation Guide
Version 4.5

GH23-0257-01

IBM



Note

Before using this document, read the general information under “Notices” on page vii.

First Edition (September 2000)

This edition applies to the following licensed programs:
v IBM VisualAge Generator Developer for OS/2 and Windows NT Version 4.5
v IBM VisualAge Generator Server for OS/2, AIX, Windows NT, HP-UX, and Solaris Version 4.5
v IBM VisualAge Generator Server for AS/400 Version 3.1
v IBM VisualAge Generator Server for AS/400 Version 3.6
v IBM VisualAge Generator Server for MVS, VSE, and VM Version 1.2

Order publications by phone or fax. IBM Software Manufacturing Solutions takes publication orders between 8:30
a.m. and 7:00 p.m. eastern standard time (EST). The phone number is (800) 879-2755. The fax number is (800)
445-9269. Faxes should be sent Attn: Publications, 3rd floor.

You can also order publications through your IBM representative or the IBM branch office serving your locality.
Publications are not stocked at the address below.

IBM welcomes your comments. You can send your comments in any one of the following methods:

Electronically, using the online reader comment form at the address listed below. Be sure to include your entire
network address if you wish a reply.
v http://www.ibm.com/software/ad/visgen

By mail to the following address:

IBM Corporation, Attn: Information Development, Department G7IA Building 062, P.O. Box 12195, Research Triangle
Park, NC 27709-2195.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information in any
way it believes appropriate without incurring any obligation to you.

© Copyright International Business Machines Corporation 1992, 1999, 2000. All rights reserved.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.



Contents

Notices . . . . . . . . . . . . . vii

Trademarks . . . . . . . . . . . . ix
Terminology used in this document . . . . x

Terminology differences between Java and
Smalltalk . . . . . . . . . . . . xii

About this document . . . . . . . . xiii
Documentation provided with VisualAge
Generator . . . . . . . . . . . . xiii

Part 1. Planning for product
installation . . . . . . . . . . . 1

Chapter 1. Considering overall VisualAge
Generator planning issues . . . . . . . 3
Migrating from a previous version of the
product . . . . . . . . . . . . . . 3
Accessing the VisualAge Generator Readme
file and Web sites . . . . . . . . . . 3

Chapter 2. Planning to install VisualAge
Generator Developer . . . . . . . . . 5
Installing stand-alone versus client and
repository server . . . . . . . . . . . 5

Installing stand-alone on VisualAge
Smalltalk . . . . . . . . . . . . 6
Installing with a shared repository on
VisualAge Smalltalk . . . . . . . . . 6
Installing stand-alone on VisualAge for Java 8
Installing with a shared repository on
VisualAge for Java . . . . . . . . . 8

Setting up a generator server. . . . . . . 9

Chapter 3. Planning to install VisualAge
Generator Common Services . . . . . 11

Part 2. Installing and uninstalling
VisualAge Generator on OS/2 . . . 13

Chapter 4. Installing VisualAge Generator
Developer for OS/2 . . . . . . . . . 15

Before you install VisualAge Generator
Developer. . . . . . . . . . . . . 15

Uninstalling previous products. . . . . 15
Hardware and software requirements for
VisualAge Generator Developer . . . . 16

Installing VisualAge Generator Developer . . 16
Preparing VisualAge Generator Developer to
use DRDA to access a database . . . . . 17

Chapter 5. Customizing VisualAge
Generator Developer for OS/2 . . . . . 19
Installing MVS support for transferring files 19

Chapter 6. Installing VisualAge Generator
Server for OS/2 . . . . . . . . . . 21
Before you install VisualAge Generator Server 21

Uninstalling previous products. . . . . 21
Hardware and software requirements for
VisualAge Generator Server . . . . . . 21

Installing VisualAge Generator Server . . . 21

Chapter 7. Customizing VisualAge
Generator Server for OS/2 . . . . . . . 23
Customizing environment variables for OS/2
and CICS for OS/2. . . . . . . . . . 23

How to customize your workstation
environment for CICS for OS/2 . . . . 23
Customizing the product-specific
environment variables. . . . . . . . 24

Customizing VisualAge Generator Server
run-time messages for OS/2 and CICS for
OS/2 . . . . . . . . . . . . . . 25
Customizing the CICS for OS/2 environment 27

Customizing the COBOL environment . . 27
Customizing a specific CICS for OS/2
environment . . . . . . . . . . . 28

Customizing error reporting . . . . . . 28
Customizing the VisualAge Generator
Server error maps . . . . . . . . . 28

Local area network considerations . . . . 29
Selecting files for LAN placement . . . . 29
Placing VisualAge Generator Server on a
LAN . . . . . . . . . . . . . 30

Saving customized files . . . . . . . . 30
Distributing customized files . . . . . 30

© Copyright IBM Corp. 1992, 1999, 2000 iii



Chapter 8. Installing VisualAge Generator
Common Services for OS/2 . . . . . . 33
Before you install VisualAge Generator
Common Services . . . . . . . . . . 33

Uninstalling previous products. . . . . 33
Installing related products . . . . . . 33
Hardware and software requirements for
VisualAge Generator Common Services . . 33

Installing VisualAge Generator Common
Services . . . . . . . . . . . . . 34

Chapter 9. Defining VisualAge Generator
Server to CICS for OS/2 . . . . . . . 35
Starting CICS for OS/2 . . . . . . . . 35
Preparing to import VisualAge Generator
Server table entries. . . . . . . . . . 36
Importing the VisualAge Generator Server
CICS resources . . . . . . . . . . . 36
Adjusting the CICS for OS/2 TWA size . . . 37
Customizing your workstation to run COBOL
programs on OS/2 . . . . . . . . . . 37

Chapter 10. Verifying the installation of
VisualAge Generator Server on CICS for
OS/2 . . . . . . . . . . . . . . 39
Verifying the run-time services environment 39
Verifying the preparation environment . . . 39

Preparation using VisualAge Generator
Developer for OS/2 . . . . . . . . 40
Using the generated IVP . . . . . . . 40

Chapter 11. Uninstalling VisualAge
Generator on OS/2 . . . . . . . . . 43

Part 3. Installing and uninstalling
VisualAge Generator on Windows . 45

Chapter 12. Installing and customizing
VisualAge Generator Developer for
Windows NT . . . . . . . . . . . 47
Before you install VisualAge Generator
Developer. . . . . . . . . . . . . 47

Uninstalling previous products. . . . . 47
Hardware and software requirements for
VisualAge Generator Developer . . . . 47

How to install VisualAge Generator
Developer. . . . . . . . . . . . . 48

Configuring a LAN generation server . . 48
Loading VAGen into your Java workspace 48

Loading VAGen into your Smalltalk image 49
Loading Templates Quickstart into your
Java workspace . . . . . . . . . . 49
Loading Templates Quickstart into your
Smalltalk image . . . . . . . . . . 49

Preparing VisualAge Generator Developer to
use DRDA to access a database . . . . . 50
Customizing VisualAge Generator Developer
for Windows NT . . . . . . . . . . 51

Installing MVS support for transferring
files . . . . . . . . . . . . . . 51

Chapter 13. Installing and customizing
VisualAge Generator Server for
Windows NT . . . . . . . . . . . 53
Before you install VisualAge Generator Server 53

Uninstalling previous products. . . . . 53
Hardware and software requirements for
VisualAge Generator Server . . . . . . 53

How to install VisualAge Generator Server. . 54
Customizing VisualAge Generator Server for
Windows NT . . . . . . . . . . . 54

Additional customization for CICS for
Windows NT . . . . . . . . . . 55
Customizing VisualAge Generator Server
run-time messages for Windows NT and
CICS for Windows NT . . . . . . . 55

Installing VisualAge Generator Server for Java 57
Setting up the environment . . . . . . 57

Chapter 14. Installing VisualAge Generator
Common Services on Windows . . . . . 59
Before you install VisualAge Generator
Common Services . . . . . . . . . . 59

Uninstalling previous products. . . . . 59
Installing related products . . . . . . 59
Hardware and software requirements for
VisualAge Generator Common Services . . 59

How to install VisualAge Generator Common
Services . . . . . . . . . . . . . 60

Chapter 15. Uninstalling VisualAge
Generator on Windows . . . . . . . . 61
Uninstalling VisualAge Generator Developer
for Windows NT . . . . . . . . . . 61
Uninstalling VisualAge Generator Server for
Windows NT . . . . . . . . . . . 61
Uninstalling VisualAge Generator Common
Services on Windows . . . . . . . . . 61

iv VisualAge Generator: Installation Guide



Part 4. Installing and uninstalling
VisualAge Generator Server on
UNIX . . . . . . . . . . . . . 63

Chapter 16. Installing and customizing
VisualAge Generator Server for AIX . . . 65
Before you install . . . . . . . . . . 65
Installing VisualAge Generator Server for AIX 65

Adding a CD-ROM file system. . . . . 65
Mounting the CD-ROM file system . . . 66
Installing the image . . . . . . . . 66

Customizing VisualAge Generator Server for
AIX . . . . . . . . . . . . . . . 67

Additional customization for CICS for AIX 68
Customizing VisualAge Generator Server
run-time messages for AIX and CICS for
AIX . . . . . . . . . . . . . . 69

Chapter 17. Installing and customizing
VisualAge Generator Server for HP-UX . . 71
Before you install . . . . . . . . . . 71
Installing VisualAge Generator Server for
HP-UX . . . . . . . . . . . . . . 71
Customizing VisualAge Generator Server for
HP-UX . . . . . . . . . . . . . . 72

Customizing VisualAge Generator Server
run-time messages for HP-UX . . . . . 73

Chapter 18. Installing and customizing
VisualAge Generator Server for SCO
OpenServer . . . . . . . . . . . . 75
Before you install . . . . . . . . . . 75
Installing VisualAge Generator Server for
SCO OpenServer . . . . . . . . . . 75
Customizing VisualAge Generator Server for
SCO OpenServer . . . . . . . . . . 76

Customizing VisualAge Generator Server
run-time messages for SCO OpenServer. . 77

Chapter 19. Installing and customizing
VisualAge Generator Server for Solaris . . 79
Before you install . . . . . . . . . . 79
Installing VisualAge Generator Server for
Solaris . . . . . . . . . . . . . . 79
Customizing VisualAge Generator Server for
Solaris . . . . . . . . . . . . . . 80

Customizing VisualAge Generator Server
run-time messages for Solaris . . . . . 81

Chapter 20. Uninstalling VisualAge
Generator Server on UNIX . . . . . . . 83
Uninstalling VisualAge Generator Server for
AIX . . . . . . . . . . . . . . . 83
Uninstalling VisualAge Generator Server for
HP-UX . . . . . . . . . . . . . . 83
Uninstalling VisualAge Generator Server for
SCO OpenServer . . . . . . . . . . 84
Uninstalling VisualAge Generator Server for
Solaris . . . . . . . . . . . . . . 84

Part 5. Appendixes . . . . . . . 87

Appendix A. Environment variable values 89

Appendix B. National language support 107
VisualAge Generator Developer national
language support . . . . . . . . . . 107

NLS characters. . . . . . . . . . 107
NLS customization . . . . . . . . 107

VisualAge Generator Server national
language support . . . . . . . . . . 110

Appendix C. Getting support . . . . . 113
Electronic support. . . . . . . . . . 113
Telephone support . . . . . . . . . 113

Telephone support for North American
customers . . . . . . . . . . . 113
Telephone support outside North America 114

VisualAge Generator Consulting Services 114
Maintaining VisualAge Generator . . . . 115

Appendix D. Installing samples for
VisualAge Generator Developer on
Smalltalk . . . . . . . . . . . . 117
Importing and loading applications . . . . 118
Importing and loading configuration maps 118
Importing database tables . . . . . . . 119
Binding to a database . . . . . . . . 119

Appendix E. Installing samples for
VisualAge Generator Developer on Java . 121
Importing and loading projects and packages 121
Importing database tables . . . . . . . 122
Binding to a database . . . . . . . . 122

Appendix F. Samples in repositories . . 123
Associated files . . . . . . . . . . 126

Contents v



Index . . . . . . . . . . . . . 127

vi VisualAge Generator: Installation Guide



Notices

References in this publication to IBM products, programs, or services do not
imply that IBM intends to make these available in all countries in which IBM
operates. Any reference to an IBM product, program, or service is not
intended to state or imply that only that IBM product, program, or service
may be used. Subject to IBM’s valid intellectual property or other legally
protectable rights, any functionally equivalent product, program, or service
may be used instead of the IBM product, program, or service. The evaluation
and verification of operation in conjunction with other products, except those
expressly designated by IBM, are the responsibility of the user.

IBM may have patents or pending patent applications covering subject matter
in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to the IBM
Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood
NY 10594, U.S.A.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact the SWS
General Legal Counsel, IBM Corporation, Department TL3 Building 062, P. O.
Box 12195, Research Triangle Park, NC 27709-2195. Such information may be
available, subject to appropriate terms and conditions, including in some
cases, payment of a fee.

IBM has made reasonable efforts to ensure the accuracy of the information
contained in this publication. If a softcopy of this publication is provided to
you with the product, you should consider the information contained in the
softcopy version the most recent and most accurate. However, this publication
is presented “as is” and IBM makes no warranties of any kind with respect to
the contents hereof, the products listed herein, or the completeness or
accuracy of this publication.

IBM may change this publication, the product described herein, or both.
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Trademarks

The following terms are trademarks of the IBM Corporation in the United
States or other countries:

AD/Cycle
AIX
AIX/6000
CICS
CICS OS/2
CICS/ESA
CICS/MVS
CICS/VSE
CICS for AIX
COBOL/370
COBOL/400
C Set ++
DATABASE 2
DB2
DB2 for OS/2
DB2 for OS/400
DB2 for AIX
Distributed Database Connection Services/2
DRDA
IBM
IBMLink
IMS
IMS/ESA
Language Environment
MQ
MVS
Operating System/2
OS/2
OS/390
OS/400
RS/6000
SAA
SQL/DS
SQL/400
VisualAge
VisualAge C++
VisualGen
Virtual Machine/Enterprise Systems Architecture
VM/ESA
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The following terms are trademarks of other companies:

Adobe Adobe Systems Incorporated

Btrieve Novell, Inc.

CompuServe CompuServe Incorporated

C++ American Telephone & Telegraph
Company

COBOL Workbench Micro Focus Limited

Gradient Technologies PC-DCE/32 NT Runtime Kit

InstallShield InstallShield Corporation

Hewlett-Packard Hewlett-Packard Company

HP-UX Hewlett-Packard Company

Intel Intel Corporation

Micro Focus Micro Focus Limited

NetWare Novell, Inc.

Novell Novell, Inc.

Oracle Oracle Corporation

Solaris Sun Microsystems, Inc.

UNIX X/Open Company Limited

Microsoft, Windows, Windows NT, Windows 2000, the Windows logo, and
the Windows 95 logo the are trademarks of Microsoft Corporation in the
United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and
other countries.

Solaris, Java, and all Java-based trademarks are trademarks of Sun
Microsystems, Inc. in the United States, other countries, or both.

Other company, product, or service names may be the trademarks or service
marks of others.

Terminology used in this document

Unless otherwise noted in this publication, the following references apply:
v MVS CICS applies to Customer Information Control System/Enterprise

Systems Architecture (CICS/ESA) systems.
v CICS applies to CICS for VSE/ESA, CICS/ESA, CICS for OS/2, CICS for

AIX, CICS for Windows NT, and CICS for Solaris.
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v CICS for Windows NT refers to IBM TXSeries for Windows NT Version 4.2.
v CICS for AIX refers to IBM TXSeries for AIX Version 4.2.
v CICS for Solaris refers to IBM WebSphere Enterprise Edition Version 3.0.
v IMS/VS applies to Information Management System/Enterprise System

Architecture (IMS/ESA) and IMS/ESA Transaction Manager systems.
v IMS applies to IMS/ESA and IMS/ESA Transaction Manager, and to

message processing program (MPP), IMS Fast Path (IFP), and batch
message processing (BMP) regions. IMS/VS is used to distinguish MPP and
IFP regions from the IMS BMP target environment.

v LE applies to the IBM Language Environment for MVS and VM.
v COBOL applies to any of the following types of COBOL:

– IBM VisualAge for COBOL for OS/2
– ILE COBOL/400
– IBM COBOL for VSE
– IBM COBOL for MVS and VM

v “Region” and “CICS region” correspond to the following:
– CICS for MVS/ESA region
– IMS region
– CICS for VSE/ESA partition
– CICS for OS/2 system
– CICS for AIX system
– CICS for Windows NT system
– CICS for Solaris system

v DB2/VSE refers to SQL/DS Version 3 Release 4 or later. Any references to
SQL/DS refer to DB2/VSE and SQL/DS on VM. In addition, any references
to SQL/400 refer to DB2/400.

v OS/2 CICS applies to CICS Operating System/2 (CICS for OS/2).
v Workstation applies to a personal computer, not an AIX workstation.
v The make process applies to the generic process not to specific make

commands, such as make, nmake, pmake, polymake.
v Unless otherwise noted, references to VM apply to Virtual

Machine/Enterprise Systems Architecture (VM/ESA) environments.
v References to VM batch apply to any batch facility running on VM.
v DB2/2 applies to DB2/2 Version 2.1 or later, and DB2 Universal Database

(UDB) for OS/2 Version 5.
v DB2/6000 applies to DB2/6000 Version 2.1 or later, and DB2 Universal

Database (UDB) for AIX Version 5.
v Windows applies to Windows 95, Windows 98, Windows NT, and

Windows 2000.
v Unless a specific version of Windows NT is referenced, statements

regarding Windows NT also apply to Windows 2000.
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Terminology differences between Java and Smalltalk
VisualAge Generator Developer can be installed as a feature of VisualAge for
Java or VisualAge Smalltalk. Where appropriate, the documentation uses
terminology that is specific to Java or Smalltalk. But where the information is
specific to VisualAge Generator and virtually the same for both environments,
the Java/Smalltalk term is used.

Table 1. Terminology differences between Java and Smalltalk

Java term Combined Java/Smalltalk
term

Smalltalk term

Project Project/Configuration map Configuration map

Package Package/Application Application

Workspace Workspace/Image Image

Beans palette Beans/Parts palette Parts palette

Bean Visual part or bean Visual part

Repository Repository/ENVY library ENVY library manager

Options Options/Preferences Preferences
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About this document

This document provides information for installing, customizing, maintaining,
and getting support for VisualAge Generator for the OS/2, Windows, AIX,
HP-UX, and Solaris environments.

Documentation provided with VisualAge Generator

VisualAge Generator documents are provided in one or more of the following
formats:
v Printed and separately ordered using the individual form number.
v Online book files (.pdf) on the product CD-ROM. Adobe Acrobat Reader is

used to view the manuals online and to print desired pages.
v HTML files (.htm) on the product CD-ROM and from the VisualAge

Generator web page (http://www.ibm.com/software/ad/visgen).

The following books are shipped with the VisualAge Generator Developer
CD. Updates are available from the VisualAge Generator Web page.
v VisualAge Generator Getting Started (GH23-0258-01) 1,2

v VisualAge Generator Installation Guide (GH23-0257-01) 1,2

v Introducing VisualAge Generator Templates (GH23-0272-01) 2,3

The following books are shipped in PDF and HTML formats on the VisualAge
Generator CD. Updates are available from the VisualAge Generator Web page.
Selected books are available in print as indicated.
v VisualAge Generator Client/Server Communications Guide (SH23-0261-01)1, 2

v VisualAge Generator Design Guide (SH23-0264-00) 1

v VisualAge Generator Generation Guide (SH23-0263-01) 1

v VisualAge Generator Messages and Problem Determination Guide
(GH23-0260-01) 1

v VisualAge Generator Programmer’s Reference (SH23-0262-01) 1

v VisualAge Generator Migration Guide (SH23-0267-00) 1

v VisualAge Generator Server Guide for Workstation Platforms (SH23-0266-01) 1,4

v VisualAge Generator System Development Guide (SG24-5467-00) 2

v VisualAge Generator User’s Guide (SH23-0268-01) 1, 2

v VisualAge Generator Web Transaction Development Guide (SH23-0281-00) 1

1. These documents are available as HTML files and PDF files on the product CD.

2. These documents are available in hardcopy format.

3. These documents are available as PDF files on the product CD.

4. This document is included when you order the VisualAge Generator Server product CD.
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The following documents are available in printed form for VisualAge
Generator Server for AS/400 and VisualAge Generator Server for MVS, VSE,
and VM:
v VisualAge Generator Server Guide for AS/400 (SH23-0280-00) 2

v VisualAge Generator Server Guide for MVS, VSE, and VM (SH23-0256-00) 2

The following information is also available for VisualAge Generator:
v VisualAge Generator External Source Format Reference (SH23-0265-01)
v Migrating Cross System Product Applications to VisualAge Generator

(SH23-0244-01)
v VisualAge Generator Templates V4.5 Standard Functions—User’s Guide

(SH23-0269-01)2, 3
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Part 1. Planning for product installation
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Chapter 1. Considering overall VisualAge Generator
planning issues

This chapter describes planning issues that you should consider before you
install VisualAge Generator.

Migrating from a previous version of the product

If you are migrating from a previous version of the product, please refer to
the VisualAge Generator Migration Guide before you install VisualAge
Generator.

Accessing the VisualAge Generator Readme file and Web sites

Before you install the VisualAge Generator product, please take the time to
read the Readme file shipped on the product’s compact disk (CD). This file
contains late-breaking installation news and tips. For the latest information,
see the online version of this installation guide at the IBM VisualAge
Generator World Wide Web site listed below.

The Readme file is provided in both HTML (readme.htm) and flat text
(readme.txt) formats. Both files are located in the Readme directory on the
VisualAge Generator CD.

You can use any Web browser to open the HTML version of the Readme file.
You can use your favorite text editor to view the text version of the Readme
file.

You can find more information about VisualAge Generator and other IBM
products on the following Web sites:

IBM VisualAge Generator
http://www.ibm.com/software/ad/visgen

IBM VisualAge Smalltalk
http://www.software.ibm.com/ad/smalltalk

IBM VisualAge for Java
http://www.software.ibm.com/ad/vajava

IBM VisualAge Resource Catalog
http://www.software.ibm.com/ad/visage/rc

IBM Software: Application Development and Object Technology
http://www.software.ibm.com/ad

© Copyright IBM Corp. 1992, 1999, 2000 3



IBM Software home page
http://www.software.ibm.com

IBM Corporation home page
http://www.ibm.com

Future fixes to VisualAge Generator will also be made available on the
Internet via anonymous FTP from the following site:
ftp://ps.software.ibm.com/ps/products/visualagegen/fixes/v4.5
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Chapter 2. Planning to install VisualAge Generator
Developer

This chapter describes planning issues that you should consider before you
install VisualAge Generator Developer.

VisualAge Generator Developer must be installed in the same directory as
VisualAge Smalltalk Enterprise Client or VisualAge for Java. You should
install VisualAge Smalltalk or VisualAge for Java before installing VisualAge
Generator Developer. If you try to install VisualAge Generator Developer
before you install Smalltalk or Java, the installation software will ask you to
install Smalltalk or Java.

Installing stand-alone versus client and repository server

If you are working alone and not planning to share your source code
repository, you will probably want to install VisualAge Generator Developer
stand-alone. If you want multiple programmers to share the repository, install
the repository on a server and the client on each workstation. You specify this
choice when you install VisualAge Smalltalk or VisualAge for Java.

Figure 1 illustrates a stand-alone installation.

Figure 2 on page 6 illustrates a shared-repository installation with a generation
server (described below).

Developer workstation

Library manager

Generation server

Figure 1. Stand-alone installation
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Installing stand-alone on VisualAge Smalltalk
To install VisualAge Generator stand-alone, do the following:
1. Install VisualAge Smalltalk 5.0.

a. In the VisualAge 5.0 Installation window, select Install Manager
Library.

b. In the Select Products and Components window, select VisualAge
Smalltalk Enterprise - Manager Library.

c. Select File I/O as the access method.
2. Install VisualAge Smalltalk 5.0 again on the same system.

a. In the VisualAge 5.0 Installation window, select Install Client.
b. In the Select Products and Components window, select VisualAge

Smalltalk Enterprise - Client.
c. Select File I/O as the access method.

3. Install VisualAge Generator Developer on top of the VisualAge Smalltalk
client.

Installing with a shared repository on VisualAge Smalltalk
To install VisualAge Generator with a shared repository, do the following:
1. Install VisualAge Smalltalk 5.0. on the system that you want to contain the

shared repository. (The repository is also called the manager library.)

Generation
server

Library manager

Developer workstations

Figure 2. Shared-repository installation
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a. In the VisualAge 5.0 Installation window, select Install Manager
Library.

b. In the Select Products and Components window, select VisualAge
Smalltalk Enterprise - Manager Library.

c. Select EMSRV as the access method.
d. Finish installing VisualAge Smalltalk.

2. Run ipconfig/all to get the host name and IP address of the system on
which the repository is installed.

3. Set up EMSRV. This process is described in detail in the VisualAge
Smalltalk Installation Guide. A simple sample installation using the default
installation directory and not using password checking involves the
following steps on a Windows NT system:
a. Add a user account named EMSRV with a password, for example,

repos4vg.
b. Add a EMSRV to the Administrators group.
c. Under User Rights Policies, grant the Administrators group the

privilege of acting as part of the operating system.
d. Reboot to make the changes to user rights take effect.
e. Go to C:\Program Files\VAST\bin and run the following command:

emsrv -u EMSRV -p repos4vg -rd

f. In the same directory, run the following command to begin installing
EMSRV as a service:
emsrv -install

g. Finish installing EMSRV as a service by going to the control panel,
selecting the Services icon, and starting the service with the same
parameters that were used in the previous step.

4. Install VisualAge Smalltalk 5.0. on the system on which VisualAge
Generator Developer will be run.
a. In the VisualAge 5.0 Installation window, select Install Client.
b. In the Select Products and Components window, select VisualAge

Smalltalk Enterprise - Client.
c. Select EMSRV as the access method.
d. When you specify the Manager Library Filename on EMSRV Machine,

specify the absolute path name. For example:
C:\Program Files\VAST\manager\mgr50.dat

5. Install VisualAge Generator Developer on top of the VisualAge Smalltalk
client.

6. If you are running EMSRV on an AIX machine, copy the following files
from C:\Program Files\VAST\import on your VisualAge Generator
Developer system to the importDirectory listed in the abt.ini file
(remember that AIX is case sensitive):

Chapter 2. Planning to install VisualAge Generator Developer 7



Hpt40DV.dat
Hpt40GS.dat
Hpt40PS.dat
Hpt40SP.dat
hptvf400.dat
Mdl3To4.dat
Mdl40s.dat

For more details about setting up a shared repository on VisualAge Smalltalk,
including how to use passwords to maintain an audit trail of library content,
see the VisualAge Smalltalk Installation Guide.

To stop the EMSRV service, run the following command in the same directory
in which emsrv was run:
emadmin stop

To list who is currently logged in to the repository, run the following
command in the same directory in which emsrv was run:
emadmin list

Installing stand-alone on VisualAge for Java
To install VisualAge Generator stand-alone, do the following:
1. Install VisualAge for Java 3.5.

a. In the VisualAge for Java, Version 3.5 - Install window, select Install
VisualAge for Java..

b. In the Setup Type window, select complete.
c. For the location of the repository, select Local.
d. Toward the end of the installation, you will be prompted whether to

continue with the secondary installation stage. Click Yes.
2. Install VisualAge Generator Developer on top of VisualAge for Java.

Installing with a shared repository on VisualAge for Java
To install VisualAge Generator with a shared repository, do the following:
1. Install VisualAge for Java Team Server 3.5. on the system that you want to

contain the shared repository. Team Server includes EMSRV and the
repository. For information on how to install Team Server, see the Team
Server documentation.

2. Run ipconfig/all to get the host name and IP address of the system on
which the repository is installed.

3. Set up EMSRV as described earlier under “Installing with a shared
repository on VisualAge Smalltalk” on page 6, except that the product
directory is C:\IBMVJava instead of C:\Program Files\VAST.

4. Install VisualAge for Java, Version 3.5. on the system on which VisualAge
Generator Developer will be run.
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a. In the VisualAge for Java, Version 3.5 - Install Selection window, select
Install VisualAge for Java, Version 3.5.

b. In the Setup Type window, select Full.
c. For the location of the repository, select Server.
d. When you specify the location of the repository, make the path name

relative to the host on which the repository resides. For example:
C:\IBMVJava\IDE\repository\ivj.dat

5. Install VisualAge Generator Developer on top of VisualAge for Java,
Version 3.5.

Setting up a generator server

If you want to free up processing resources on each developer workstation,
you can set up a generator server that runs batch generations for each
developer. For details on how to do this, see the VisualAge Generator Generation
Guide.
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Chapter 3. Planning to install VisualAge Generator
Common Services

VisualAge Generator Common Services is used by VisualAge Generator
Developer and VisualAge Generator Server. Table 2 on page 12 shows the
server and client platforms supported by VisualAge Generator Common
Services.
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Table 2. Platforms and protocols supported by Common Services

Client platforms

Server
platforms OS/2

Windows 95
and
Windows 98

Windows
NT AIX Solaris

AIX TCP/IP,
DCE

TCP/IP,
DCE

TCP/IP,
DCE

TCP/IP,
DCE, IPC,
DIRECT

TCP/IP,
IPC,
DIRECT

CICS for AIX CICS Client CICS Client CICS Client CICS Client CICS Client

HP-UX TCP/IP TCP/IP TCP/IP TCP/IP TCP/IP

IMS APPC/IMS APPC/IMS APPC/IMS (not
supported)

(not
supported)

CICS for
MVS/ESA

CICS Client,
LU2

CICS Client CICS Client CICS Client CICS Client

OS/2 TCP/IP,
DCE, IPC,
DIRECT

TCP/IP,
DCE

TCP/IP,
DCE

TCP/IP,
DCE

TCP/IP

CICS for
OS/2

CICS Client CICS Client CICS Client CICS Client CICS Client

OS/400 CA/400 CA/400 CA/400 (not
supported)

(not
supported)

SCO TCP/IP TCP/IP TCP/IP TCP/IP TCP/IP

Solaris TCP/IP TCP/IP TCP/IP TCP/IP TCP/IP

CICS for
Solaris

CICS Client CICS Client CICS Client CICS Client CICS Client

VM/ESA TCP/IP TCP/IP TCP/IP TCP/IP TCP/IP

CICS for
VSE/ESA

CICS Client CICS Client CICS Client CICS Client CICS Client

Windows NT TCP/IP,
DCE

TCP/IP,
DCE

TCP/IP,
DCE, IPC,
DIRECT

TCP/IP,
DCE

TCP/IP

CICS for
Windows NT

CICS Client CICS Client CICS Client CICS Client CICS Client
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Part 2. Installing and uninstalling VisualAge Generator
on OS/2
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Chapter 4. Installing VisualAge Generator Developer for
OS/2

This chapter describes how to install VisualAge Generator Developer on
OS/2. It includes the following information:
v What to do before you install the product
v Installation instructions

Sample applications are also installed with the product. See “Appendix D.
Installing samples for VisualAge Generator Developer on Smalltalk” on
page 117 for more information.

Before you install VisualAge Generator Developer

Before you begin installing VisualAge Generator Developer for OS/2, read the
sections below for important information about uninstalling previous products
and about hardware and software requirements.

Uninstalling previous products
If you are migrating from a previous version of VisualGen Developer or
VisualAge Generator Developer, delete that version before installing Version
4.5 of VisualAge Generator Developer for OS/2; then reboot. Coexistence of
Version 4.5 is not supported with any previous version of VisualGen
Developer or VisualAge Generator Developer on the same workstation. For
more information about deleting these products from your workstation, see
“Chapter 11. Uninstalling VisualAge Generator on OS/2” on page 43.

In addition, before you delete the previous release of VisualAge Generator, do
the following:
v Save copies of any templates or options (for example, reserved words) files

you modified and which are still in the product directories
v Save the LAN generation command files (EFKSERV.CMD and

EFKREQ.CMD) if you made modifications to these files.
v If you are migrating from a version of VisualAge Generator before 3.1, any

programs for the C++ target environments must be regenerated for
VisualAge Generator 4.5. If you are migrating COBOL programs, you do
not need to regenerate unless you want to take advantage of new features
in Version 4.5.

v For CICS OS/2, the default parmform option in the linkage table was
COMMDATA. With VisualAge Generator 3.0 and 3.1, the option
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COMMPTR is the default. Therefore, if you never specified linkage tables
for CICS OS/2, you might need a linkage table now.

Then delete the previous version, reboot, install the new version and reboot
again.

For more information about migrating from previous releases of VisualAge
Generator, refer to the VisualAge Generator Migration Guide (SH23-0267-00) and
Migrating Cross System Product Applications to VisualAge Generator
(SH23-0244-01) documents.

Hardware and software requirements for VisualAge Generator Developer
Before you can run VisualAge Generator Developer for OS/2, you must install
VisualAge Generator Common Services. For additional hardware and software
requirements for the product, software requirements for program generation
on OS/2, and software requirements for VisualAge Generator preparation on
target environments, go to the IBM VisualAge Generator Web site
(http://www.ibm.com/software/ad/visgen) and click on the “Hardware and
software requirements” link.

Installing VisualAge Generator Developer

This section describes how to locally install VisualAge Generator Developer
for OS/2. To install VisualAge Generator Developer locally, complete the
following steps:
1. Open an OS/2 window or an OS/2 full-screen session.
2. Insert the VisualAge Generator Developer CD into your CD-ROM drive.
3. At the OS/2 prompt, type the following command:

d:\xxx\install\install.exe

where d is the CD-ROM drive containing the CD and xxx is the
three-character NLS code. For more information on NLS codes see
“VisualAge Generator Developer national language support” on page 107.

4. Follow the instructions on the install screens to complete the installation;
but if you are installing remote DL/I support, do the following before
rebooting:
a. Open the file c:\config.sys.
b. Provide an appropriate value in the SET statement for environment

variable RMTDLI_PARTNER_LU, which specifies the name of the
partner LU alias used during remote DL/I access.

c. Provide an appropriate value in the SET statement for environment
variable RMTDLI_PARTNER_TP, which specifies the TP name of the
remote DL/I server used during remote DL/I access.

d. Save the file.
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After you install VisualAge Generator Developer, you must load VisualAge
Generator Developer into your image:
1. From the desktop, double-click on the IBM VisualAge Generator V4.5

folder. Double-click on the Developer on Smalltalk icon to start VisualAge
Smalltalk.

2. From the Organizer Options pull-down, select Load/Unload features.
3. On the Selection Required window:

a. Make sure the Show other features checkbox is checked.
b. In the Available features pane, select VAGen45 Developer.
c. Select the >> button to move VAGen45 Developer to the Loaded

features pane.
d. If you want to use ITF partitioning, select VAGen45 Partitioning

Support.
e. Select VAGen45 GUI Settings if you need to use notebook style

settings to access options that might not be available from the
properties window.

Note: Since VisualAge Smalltalk no longer supports this option, it is
not recommended.

f. If you want to use VisualAge Generator Templates, select
VAGTemplates Standard Functions. You have the option of also
selecting VAGTemplates Quick Start 4.5 or VAGTemplates V3 to V4
Migration 4.5.

g. Click on OK. The VisualAge Generator components are imported and
loaded into your image. This might take 2 or more hours.

h. After VAGen is loaded, you are prompted to save your image. Select
Yes so you do not have to load VAGen the next time you start
VisualAge Smalltalk. The image is saved as file abt.icx by default. After
the image is saved, make a copy of the image file.

For more information, refer to the VisualAge Generator System Development
Guide.

Preparing VisualAge Generator Developer to use DRDA to access a database

VisualAge Generator Developer uses access plan DEVELOP.xxx when
accessing data from a relational database. The access plan, also known as a
package, is used when developing, testing, and validating VisualAge
Generator programs. When multiple developers are accessing the same
database from VisualAge Generator, they all share the same access plan.
Because of the potential for deadlock situations to occur, it is recommended
that a database administrator performs the following tasks.
1. Creating the VisualAge Generator Collection
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The VisualAge Generator access plan, when bound to the database, is
created in a collection called DEVELOP. On most IBM relational database
management systems, this collection is created automatically at bind time.
For DB2/400, the collection, DEVELOP, must first be created by issuing
the following command from the SQL Interactive Session (STRSQL):
CREATE COLLECTION DEVELOP

For the following databases, the collection is created automatically when
the access plan is bound, if you have database administrator authority:
v DB2/MVS
v DB2/VM
v DB2/VSE
v DB2/NT
v DB2/AIX

2. Preparing the access plan
The VisualAge Generator access plan contains some SQL statements that
are not supported by all databases. To account for these differences, you
need to create the access plan outside of VisualAge Generator. To create
the VisualAge Generator package on the target database system, the
database administrator needs to perform the following steps on the DB2
Connect or DDCS/2 gateway machine:
a. Make sure that the VisualAge Generator bind file HPTDB245.BND is

accessible to the DB2 Connect or DDCS/2 gateway machine.
b. Type the following commands in your DB2 command-line processor

window:
db2 connect to DBNAME user USERID using PASSWORD
db2 bind path\HPTDB245.BND blocking all sqlerror continue messages
vgbind.msg datatime XXX grant public
db2 connect reset

where DBNAME, USERID, and PASSWORD apply to the DRDA server
and xxx is the desired date and time stamp format.
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Chapter 5. Customizing VisualAge Generator Developer for
OS/2

This chapter describes customizing VisualAge Generator Developer for OS/2.
Before you begin customizing, complete all the appropriate steps in “Installing
VisualAge Generator Developer” on page 16.

You can customize VisualAge Generator Developer for OS/2 by installing
MVS support for transferring files. You can also customize VisualAge
Generator Developer by using the VAGen Preferences notebook.

Installing MVS support for transferring files

The tasks in this section are needed only if you have variable-length VSAM
files and you need to install the ELACOVTF utility.

Files that contain a file conversion utility, supporting JCL code, and a CLIST,
are included with VisualAge Generator Developer in the product directory.
These files have the following names:

EZERCLS2.DSN
EZERLMD2.DSN
EZERHOST.DSN

To install these files on your MVS host, complete the following steps:
1. Start Personal Communications.
2. Log on to an MVS host session and ensure that you are at a READY

prompt.
3. Transfer the files to the MVS host system by using the following

commands:
SEND EZERCLS2.DSN A:'EZED30.SEZECLS2.OUTDSN'
SEND EZERLMD2.NLS A:'EZED30.SEZELMD2.OUTDSN'
SEND EZERHOST.NLS A:'EZED30.SEZEHOST.OUTDSN'

where A: is the host session identifier.

Notes:

a. This step assumes you have authority to create MVS data sets with the
EZED30 prefix. If not, specify your user ID instead of EZED30 and
make the appropriate changes to the JCL and CLIST described below.

b. You only need to transfer files if you have variable length VSAM files.
See the VisualAge Generator Server Guide for download procedures. See
the online help for information on how to use the SEND command.
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If you are transferring from a DBCS operating system (OS/2J, OS/2H,
OS/2T), you must append a left square bracket ([) at the end of the
command. There should be at least one space between the command and
the left bracket ([).

4. Before the data sets can be used on MVS, you must do a TSO RECEIVE
for each data set, using the INDSN parameter. Type the following
commands:
RECEIVE INDSN('EZED30.SEZECLS2.OUTDSN')
RECEIVE INDSN('EZED30.SEZELMD2.OUTDSN')
RECEIVE INDSN('EZED30.SEZEHOST.OUTDSN')

If you are transferring from a DBCS operating system (OS/2J, OS/2H,
OS/2T), you must append a left square bracket ([) at the end of the
command. There should be at least one space between the command and
the left bracket ([).

For each of these commands you will be prompted for restore parameters.
Specify one of the following commands:
DA('EZED30.SEZECLS2')
DA('EZED30.SEZELMD2')
DA('EZED30.SEZEHOST')

5. After the data sets have been successfully installed on MVS, complete the
following steps:
a. Run the job EZED30.SEZEHOST(EZECJVCL) to create a

variable-blocked CLIST data set.
b. If you use variable-blocked CLISTs, use JCL procedure

EZED30.SEZEHOST(EZECOPRF) to run the EZECOVTF utility.

Note: You can also copy EZED30.SEZEHOST(EZECOPRF) to a
PROCLIB on your system.
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Chapter 6. Installing VisualAge Generator Server for OS/2

This chapter describes how to install VisualAge Generator Server on OS/2. It
includes:
v What to do before you install the product
v Installation instructions

Sample applications are also installed with the product. See “Appendix D.
Installing samples for VisualAge Generator Developer on Smalltalk” on
page 117 for more information.

Before you install VisualAge Generator Server

Before you begin installing VisualAge Generator Server for OS/2, read the
sections below for important information about uninstalling previous products
and about hardware and software requirements.

Uninstalling previous products
If you have a previous version of VisualGen Workgroup Services, VisualAge
Generator Workgroup Services, or VisualAge Generator Server installed on a
workstation, delete it before installing VisualAge Generator Server 4.5.
Coexistence of VisualAge Generator Server for OS/2 4.5 is not supported with
any previous version of the above-mentioned products on the same
workstation. For more information about deleting these products from your
workstation, see “Chapter 11. Uninstalling VisualAge Generator on OS/2” on
page 43.

Hardware and software requirements for VisualAge Generator Server
Before you can run VisualAge Generator Server for OS/2 and CICS for OS/2,
you must install VisualAge Generator Common Services. For additional
hardware and software requirements, go to the IBM software Web site
(http://www.ibm.com/software/ad/visgen) and click on the “Hardware and
software requirements” link. The information listed includes requirements for
installing VisualAge Generator Server for OS/2 and CICS for OS/2 and for
running generated programs.

Installing VisualAge Generator Server

This section describes how to locally install VisualAge Generator Server for
OS/2. To install VisualAge Generator Server locally, complete the following
steps:
1. Switch to or start an OS/2 window or an OS/2 full-screen session.

© Copyright IBM Corp. 1992, 1999, 2000 21



2. Insert the VisualAge Generator Server CD into your CD-ROM drive.
3. At the OS/2 prompt, type the following command:

d:\xxx\install\install.exe

where d is the CD-ROM drive containing the CD and xxx is the
three-character NLS code. For more information on NLS codes see
“VisualAge Generator Developer national language support” on page 107.

4. Follow the instructions on the install screens to complete the installation.
5. The installation of your selected components is now complete. Select Exit

to close the installation program.

You must customize certain aspects of VisualAge Generator Server before you
begin using the product. See “Chapter 7. Customizing VisualAge Generator
Server for OS/2” on page 23 for information about customizing VisualAge
Generator Server.
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Chapter 7. Customizing VisualAge Generator Server for
OS/2

This chapter describes the following customization tasks:
v Customizing environment variables for OS/2, CICS for OS/2, and

client/server communications support
v Customizing the VisualAge Generator Server run-time messages for OS/2

and CICS for OS/2
v Customizing the CICS for OS/2 environment

After the installation is complete, you can also customize the VisualAge
Generator Server profiles. Refer to the VisualAge Generator Server Guide for
Workstation Platforms document for more information about customizing the
VisualAge Generator Server profiles.

Customizing environment variables for OS/2 and CICS for OS/2

By default, the installation utility updates the CONFIG.SYS file with the
information that VisualAge Generator Server components need to run.

If you enable the installation utility to update the CONFIG.SYS file:
v You can still customize the environment later.
v The installation utility does not add any SET statements to the

CONFIG.SYS file for any of the optional environment variables.
v The installation utility creates CONFIG.BAK, a backup copy of the

CONFIG.SYS file, before any modifications are made to the CONFIG.SYS
file. You can compare CONFIG.BAK to the modified CONFIG.SYS file to
ensure the changes are appropriate for your workstation.

How to customize your workstation environment for CICS for OS/2
There are several ways to define your workstation environment with the
environment variables required by VisualAge Generator Server for CICS for
OS/2.

The LIBPATH statement can be defined only in the CONFIG.SYS file. Other
environment variables can be customized by using any of the following
methods:
v Define the environment variables using a command file or REXX program.

These values are effective only in the OS/2 session where the command file
or program has previously run.
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v Define the environment variables using the ELAENV command file. These
values are effective whenever ELAENV.CMD runs.
ELAENV.CMD is used by VisualAge Generator Server commands and
utilities to establish their run-time environment. ELARUNC accesses
ELAENV.CMD. In addition, VisualAge Generator Developer preparation
templates can be modified to access ELAENV.CMD. The ELAENV.CMD file
should be reviewed and updated to reflect the correct directories and
defaults that are being used by your workstation.
You should be aware of the following limitations when using ELAENV:
– The LIBPATH cannot be set using ELAENV.
– The LIBPATH can only be set in the CONFIG.SYS file.
– The following environment variables are used by VisualAge Generator

Server utilities before ELAENV is accessed. Therefore, these should be
set in the CONFIG.SYS file.

EZERNLS
HELP
PATH

v Define the environment variables in the CONFIG.SYS file. These values are
effective in all OS/2 sessions. The installation utility can do this during the
installation, or you can do the customization manually. Note that even if
the installation utility updates CONFIG.SYS, there are other optional
environment variables that you may want to add manually.

Customizing the product-specific environment variables
If you do not allow the installation utility to update the CONFIG.SYS file,
some of the following product-specific environment variables must be defined
for the environment so that they can be used by the VisualAge Generator
Server for CICS for OS/2 and OS/2.

For a complete description of the environment variables, see “Appendix A.
Environment variable values” on page 89.

Table 3 provides a summary of the CONFIG.SYS environment variables used
by OS/2 and CICS for OS/2.

Table 3. Product-specific environment variables in CONFIG.SYS

Environment variable OS/2 CICS for OS/2

BTRINTF X

CICSRGRP X

CICSWRK X

CICSCOBCOPY X

CICSCOBOL X
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Table 3. Product-specific environment variables in CONFIG.SYS (continued)

Environment variable OS/2 CICS for OS/2

CICSRD X

COBPATH X

CSODIR X

CSOTROPT X

CSOTROUT X

ELAPATH X

ELARTRDB_tttt X

EZEREDIT X

EZERGRGL_xxx X X

EZERGRGS_xxx X X

EZERJULL_xxx X X

EZERJULS_xxx X X

EZERNLS X X

EZERSQLDB X X

EZERSQLFT X X

EZERSQLM1 X

EZERSQLM2 X

EZERSQLMF X

EZERSQLUS X

FCWDBNAME_progname X

FCWDPATH X

FCWMAKE X

FCWRSC X

FCWTROPT X

FCWTROUT X

Customizing VisualAge Generator Server run-time messages for OS/2 and CICS
for OS/2

Run-time messages report that a condition that is not handled by a program
has occurred. These messages can be modified to provide more information to
the user. You may also change the actual error map to display with additional
information. See “Customizing the VisualAge Generator Server error maps”
on page 28 for more information.
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Error messages that are used by the generated COBOL programs provided
with VisualAge Generator Server are stored in the ELAMxxx.TAB file. Error
messages that are used by the generated C++ programs provided with
VisualAge Generator Server are stored in the FCWxxx.TAB file. This file
contains default messages that should be acceptable for most situations.

If you elect to customize these messages, do the following:
1. Import the external source format source information containing the

VisualAge Generator Server error messages into a target ENVY
application.
For CICS for OS/2, this external source format information is available as
ELACxxx.ESF on the workstation in the C:\VGSVR45\SAMPLES directory.
For OS/2, this external source format information is available as
FCWxxx.ESF on the workstation in the C:\VGSVR45\SAMPLES directory.

Note: The xxx refers to the language version. See “VisualAge Generator
Server national language support” on page 110 for a listing of the
language codes.

2. Use the VisualAge Generator Developer Table Editor to change the
message text, which is in the second column in the table.
Ensure that you do not modify anything other than the second column.
The order of message inserts can change, but the number and format
specifications for the message inserts must not be changed.
A message insert appears as the following string format in the message
text:
%nntll

nn Specifies the relative position of the text string to be substituted for the
insert, such as 01 for the first text string or 02 for the second

t Specifies the type of the insert:
C Character
D Numeric
X Hexadecimal

ll Specifies the maximum length of the text string to place in the
message, such as 08 for 8 characters.

3. Using VisualAge Generator Developer, generate a new message table for
the CICS for OS/2 or OS/2 environment. If you are generating for CICS
for OS/2, a file named ELACxxx.TAB should be created. If you are
generating for OS/2, a file named FCWxxx.TAB should be created.

Note: The xxx refers to the language version. See “VisualAge Generator
Server national language support” on page 110 for a listing of the
language codes.
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Different types of files are generated for the message tables depending on
your target environment.

For both CICS for OS/2 and OS/2 these files should be placed in the
C:\VGSVR45\SAMPLES directory.

4. Make a backup copy of the current message table files.
5. Delete the existing message table files.
6. Copy the new message table files into the appropriate location.
7. Your customized message table will be in effect the next time you restart

CICS for OS/2 or run a VisualAge Generator program on OS/2.
Start CICS for OS/2 by double-clicking on the Start CICS for OS/2 with
VisualAge Generator Support icon.
If this icon does not start CICS successfully, see “How to customize your
workstation environment for CICS for OS/2” on page 23 for information
on ELARUNC.CMD.
You can also use the New Copy utility to cause the new message table to
be picked up while CICS for OS/2 is running.

Customizing the CICS for OS/2 environment

The following are the required tasks for customizing VisualAge Generator
Server for the CICS for OS/2 environment:
v Customizing the COBOL environment
v Customizing for a specific CICS for OS/2 environment

The following are the optional tasks for customizing VisualAge Generator
Server for the CICS for OS/2 environment:
v Customizing error reporting
v LAN considerations
v Saving customized files
v Distributing customized files

Customizing the COBOL environment
VisualAge Generator Server uses COBOL in the default directory
C:\IBMCOBOL. If COBOL was installed on a different drive, or if the default
directory was not used, the ELAENV.CMD file needs to be modified.

In ELAENV.CMD, do the following:
v Change

cobol_install_drive

to the drive in which COBOL was installed.
v Change

cobol_install_dir
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to the directory in which COBOL was installed.

Customizing a specific CICS for OS/2 environment
VisualAge Generator Server supports multiple types of CICS for OS/2
installations. By default, VisualAge Generator Server files assume that CICS
for OS/2 is installed on the C-drive. If this is not the case, the ELAENV.CMD
file needs to be modified as follows:
v Change

cics_install_drive

to the drive in which CICS for OS/2 was installed.
v Change

cics_install_dir

to the directory in which CICS for OS/2 was installed.

Customizing error reporting

This section discusses customizing the error reporting process. This process is
about error maps and run-time messages. Error maps report that a severe
error has occurred and can provide instructions about what to do next.

Customizing the VisualAge Generator Server error maps
VisualAge Generator Server supplies messages called error maps that CICS
for OS/2 displays. These messages are acceptable for most situations.
However, you can customize the error maps to provide information required
by your establishment or enterprise. For example, you might choose to modify
the error map ELAM02 to include information on contacting a support
organization.

If you elect to customize these maps, do the following:
1. Import the external source format information containing the VisualAge

Generator Server error map group into an ENVY application that
VisualAge Generator Developer has access to. This external source format
information is available as ELAxxx.ESF on the workstation in the
C:\VGSVR45\SAMPLES directory. The xxx refers to the language version.
See “VisualAge Generator Server national language support” on page 110
for a listing of valid language codes.

2. Use the VisualAge Generator Developer Map Editor to change the
presentations of the error maps. While you are changing the maps, do not
modify any of the following for the variable fields on the maps:
v Size
v Type
v Edit order
v Edit characteristics
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3. Using VisualAge Generator Developer, generate a new set of the ELAxxx
maps. The xxx refers to the language version. See “VisualAge Generator
Server national language support” on page 110 for a listing of the valid
language codes.

4. Prepare the generated map group.
5. Change directory to C:\VGSVR45\DLL\
6. Make a backup copy of the current map group DLL, ELAxxxFM.DLL. The

xxx refers to the language version. See “VisualAge Generator Server
national language support” on page 110 for a listing of the valid language
codes.

7. Copy the modified map group DLL into C:\VGSVR45\DLL.

Local area network considerations

If you are running VisualAge Generator Server programs in a local area
network (LAN) environment, you might choose to place some of the
VisualAge Generator Server product files on a shared resource on the LAN
server. If you decide to do this, you must ensure that you meet the licensing
requirements of all products involved, including VisualAge Generator Server.
The following sections list the advantages and disadvantages of placing some
files on the LAN server.

Selecting files for LAN placement
Most VisualAge Generator Server product files are not modified by running
programs or utility programs. This makes them excellent candidates for
placement on a shared LAN server resource.

The files that are modified, such as your profiles, are generally not good
candidates for placement on a shared LAN resource.

Note: If REXX files are selected for placement on the LAN, the REXX
command files should be run first by a LAN administrator or a user
with WRITE access to the LAN disk. Running the REXX file causes a
precompile of the REXX command files. Precompiling increases
performance and prevents WRITE errors for the audit log for the LAN
disk.

Do the following to store a compiled image of each of the REXX command
files. The output produced by the commands is not important.
1. Switch to the directory containing the REXX command files. The default

directory is C:\VGSVR45\EXE.
2. Enter each of the following commands, one at a time, at the OS/2

command prompt:
a. ELA2LVL.CMD
b. ELARUNC.CMD
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c. ELAENV.CMD

The extended attributes for these files are now nonzero.

Refer to your REXX documentation for more information concerning REXX
commands.

Placing VisualAge Generator Server on a LAN
Do the following to place the product on a LAN:
1. Install VisualAge Generator Server on the LAN server following the

information in “Installing VisualAge Generator Server” on page 21.
2. Create a LAN resource for the VisualAge Generator Server product

directory and its subdirectories. Assign READ and EXECUTE authority to
this resource.

3. Customize the product files using the LAN resource rather than the
default locations. See “Chapter 7. Customizing VisualAge Generator Server
for OS/2” on page 23 for more information on customizing VisualAge
Generator Server.

4. Update the program group entries and the CONFIG.SYS file for each
workstation.

5. If REXX files are selected for placement on the LAN, the REXX command
files must be run first by a LAN administrator or a user with WRITE
access to the LAN disk. An error occurs if a user without WRITE access
first runs REXX command files because REXX is storing a compiled image
of each command file with the extended attributes for the file.

Saving customized files

The following files are customized by the user. After you have modified these
files, make a backup copy of these files so that if the files are reshipped for
maintenance then your changes are not lost.
v ELAENV.CMD
v ELARUNC.CMD

Distributing customized files
If you have several workstations where you plan to make the same
customized changes to the VisualAge Generator Server files, you can save
time by customizing these files on one workstation and placing the updates
on a LAN drive. By taking the time to do this first, all subsequent installations
will install the customized files.

Take the following steps:
1. Install VisualAge Generator Server on a workstation. See “Installing

VisualAge Generator Server” on page 21.
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2. Customize the files following the steps described in “Chapter 7.
Customizing VisualAge Generator Server for OS/2” on page 23.

3. Use the OS/2 XCOPY command with /S parameter to copy the VGSVR45
directory and all its subdirectories from the CD to a LAN drive.

4. Replace the customized files on the LAN drive.
5. Make a backup copy of the customized files.
6. The customized product can now be installed directly from the LAN drive.

A description of the workstation files is as follows:

ELARUNC.CMD
Starts CICS for OS/2, making VisualAge Generator Server run-time
services available.

ELAENV.CMD
Sets up an OS/2 environment so that VisualAge Generator Server
utilities and run time can be used.
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Chapter 8. Installing VisualAge Generator Common
Services for OS/2

This section describes how to install VisualAge Generator Common Services
on OS/2. It includes:
v What to do before you install the product
v Installation instructions

Sample applications are also installed with the product. See “Appendix D.
Installing samples for VisualAge Generator Developer on Smalltalk” on
page 117 for more information.

Before you install VisualAge Generator Common Services

Before you begin installing VisualAge Generator Common Services for OS/2,
read the sections below for important information about uninstalling previous
products, installing related products, and getting a list of hardware and
software requirements.

Uninstalling previous products
If you have a previous version of VisualGen Common Services or VisualAge
Generator Common Services installed on a workstation, delete it before
installing VisualAge Generator Common Services for OS/2 4.5. Coexistence of
Version 4.5 is not supported with any previous version of the
above-mentioned products on the same workstation. For more information
about deleting these products from your workstation, see “Chapter 11.
Uninstalling VisualAge Generator on OS/2” on page 43.

Installing related products
VisualAge Generator Common Services is required to run VisualAge
Generator Developer and VisualAge Generator Server. It is also required to
run GUI clients. You must install VisualAge Generator Common Services
before you can run VisualAge Generator Developer or VisualAge Generator
Server.

Hardware and software requirements for VisualAge Generator Common
Services

You must have an HPFS file system on which to install VisualAge Generator
Common Services for OS/2. For a list of other hardware and software
requirements, go to the IBM software Web site
(http://www.ibm.software.com/vagen) and click on the “Hardware and
software requirements” link.
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Installing VisualAge Generator Common Services

This section describes how to locally install VisualAge Generator Common
Services for OS/2. To install VisualAge Generator Common Services locally,
complete the following steps:
1. Switch to or start an OS/2 window or and OS/2 full-screen session.
2. Insert the VisualAge Generator Common Services CD into your CD-ROM

drive.
3. At the OS/2 prompt, type the following command:

d:\xxx\install\install.exe

where d is the CD-ROM drive containing the CD and xxx is the
three-character NLS code. For more information on NLS codes see
“VisualAge Generator Developer national language support” on page 107.

4. Follow the instructions on the install screens to complete the installation.
5. The installation of your selected components is now complete. Select Exit

to close the installation program.

You must customize certain aspects of VisualAge Generator Common Services
before you begin using the product. See “Chapter 7. Customizing VisualAge
Generator Server for OS/2” on page 23 for information about customizing
VisualAge Generator Common Services.
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Chapter 9. Defining VisualAge Generator Server to CICS
for OS/2

The CICS for OS/2 resources associated with VisualAge Generator Server
need to be defined to CICS for OS/2 so that they can be used as part of your
CICS for OS/2 system. In addition, some CICS for OS/2 system values must
be set to certain minimum values for generated programs to function
properly.

The CICS for OS/2 resource table entries for VisualAge Generator Server are
available in the program group VGSERV in the CICS for OS/2 export file
ELAEX300.BTR. You can use the CICS OS/2 import transaction, CAIM, to
import these resource table definitions into your workstation’s CICS for OS/2
resource tables. For more information, refer to your CICS for OS/2
documentation.

The maximum Transaction Work Area (TWA) size for the CICS for OS/2
system needs to be large enough to accommodate all programs running on
the system. For VisualAge Generator generated programs, this size must be
1024 plus the largest TWAOFF value being used. For more information, see
“Adjusting the CICS for OS/2 TWA size” on page 37.

If you have elected not to accept all the installation defaults, you should
substitute your customized values where appropriate in this section.

Starting CICS for OS/2

You can start CICS for OS/2 so that the VisualAge Generator Server
environment is defined for running VisualAge Generator programs by doing
either of the following:
v Double-click on the program entry Start CICS OS/2 with VisualAge

Generator Support in the VisualAge Generator Server (English) Desktop
Manager program group to run the ELARUNC command.

v Enter the ELARUNC command at an OS/2 command prompt.

Note: The ELARUNC.CMD is primarily a sample file. Before you use it,
validate the file and make any necessary changes.

To run a program under CICS for OS/2, enter the name of the transaction
associated with the program. Refer to your CICS for OS/2 documentation for
other methods for starting transactions.
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Preparing to import VisualAge Generator Server table entries

CICS for OS/2 reads and writes import and export files from the file resource
FAAAEFIE, which is an entry in the file control table (FCT).

To import the CICS for OS/2 resource table entries for VisualAge Generator
Server, do the following:
1. Back up the contents of the current import file by doing the following:

a. Switch to or start an OS/2 window or an OS/2 full screen session.
b. Change directories to your CICS data directory.
c. Copy the file by entering the following command at the OS/2

command prompt:
COPY FAAAEFIE.BTR FAAAEFIE.BAK

Where FAAAEFIE.BAK can be any name you choose.
2. Replace the contents of the current import file with the file containing the

VisualAge Generator Server resource table entries by typing the following
command at the OS/2 command prompt:
COPY C:\VGSVR45\ELAEX300.BTR FAAAEFIE.BTR

Where c is the drive where you installed VisualAge Generator Server.

Importing the VisualAge Generator Server CICS resources

Import the FAAAEFIE.BTR file into CICS for OS/2 by doing the following:
1. Start CICS for OS/2 using the ELARUNC command file.
2. Sign on to the CICS for OS/2 user ID, SYSAD.
3. Start the CICS for OS/2 transaction CAIM to display the import panel.
4. Type the following values into the indicated fields:

Field Value
Group name VGSERV
Include conversion templates N
Include SNT N
Include data files Y
Import from backup file N
Backup existing data Y

5. Press Enter to start the import operation.
6. Repeat steps 4 and 5 with the group name EZERSMP if you plan to run

the VisualAge Generator sample programs under CICS for OS/2 on this
workstation.
These changes will be in effect once CICS for OS/2 is stopped and
restarted.
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Adjusting the CICS for OS/2 TWA size

The maximum size of the transaction work area (TWA) must be 1024 bytes for
programs using VisualAge Generator Server run-time services. If you generate
using the TWAOFF option, then the minimum size is 1024 plus TWAOFF.
Refer to the VisualAge Generator Generation Guide document for more
information about TWAOFF.

The maximum size of the transaction work area (TWA) is set in the CICS for
OS/2 System Initialization Table (SIT). Only one SIT is used when a CICS for
OS/2 system is started. Typically, the SIT associated with the FAASYS group
is used. The CEDA transaction can be used to modify this or another SIT so
that the appropriate maximum TWA size is being used.

You must stop and start CICS for OS/2 again before the new value takes
affect.

Customizing your workstation to run COBOL programs on OS/2

For information on how to customize your workstation to run COBOL
programs on OS/2, see the VisualAge Generator Server Guide for Workstation
Platforms.
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Chapter 10. Verifying the installation of VisualAge
Generator Server on CICS for OS/2

After you have completed the installation, you can verify that VisualAge
Generator Server for the CICS for OS/2 environment is installed and
customized correctly.

Verifying the run-time services environment

Do the following to verify that the VisualAge Generator Server run-time
services environment is correctly installed:
1. Start CICS for OS/2.

Start CICS for OS/2 by double-clicking on the Start CICS for OS/2 with
VisualAge Generator Support icon or by entering ELARUNC at an OS/2
command prompt.
If this icon does not start CICS successfully, see “How to customize your
workstation environment for CICS for OS/2” on page 23 for information
on ELARUNC.CMD.

2. If you would like to sign on to a user ID, but have not established any
user IDs on the system, sign on to the user ID, SYSAD. However, this is
not necessary for verifying the installation.

3. Type ELAM to run the ELAM transaction. If the CICS Utilities window
does not appear, review the installation steps and install the product again.

4. You have now verified the run-time services environment. You can take
this opportunity to become familiar with the CICS utilities in this menu:

New Copy
Enables you to request that a new copy of a table be used by
subsequent transactions.

Diagnostic Message Printing Utility
Enables you to print the diagnostic messages to a printer or OS/2
file.

Diagnostic Control Options
Enables you to specify alternate error message queues and change
the actions resulting from failing programs.

Verifying the preparation environment

VisualAge Generator Server provides external source format for an installation
verification program (IVP) so that you can test your preparation environment.
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This external source format file is called ELAIVP6.ESF and it can be found in
the C:\VGSVR45\SAMPLES directory.

Note: You would only verify the preparation environment if you were
planning to do preparation on the same machine. In addition, this type
of verification requires all of the products used by the generation and
preparation process.

Preparation using VisualAge Generator Developer for OS/2
Do the following steps to prepare using VisualAge Generator Developer:
1. Import the IVP external source format into an ENVY application using

VisualAge Generator Developer.
2. Generate and prepare the IVP for the CICS for OS/2 environment using

VisualAge Generator Developer. Refer to the VisualAge Generator Generation
Guide document for more information.

Using the generated IVP
Do the following steps to use the installation verification program:
1. Place the files created by the preparation process into a directory in your

CICSWRK path or create a directory for these files, such as
C:\VGSVR45\IVP. Copy the files to this directory. If you created a new
directory, add the directory to your CICSWRK path.

2. Start CICS for OS/2.
Start CICS for OS/2 by double-clicking on the Start CICS for OS/2 with
VisualAge Generator Support icon or by entering ELARUNC at an OS/2
command prompt.
If this icon does not start CICS successfully, see “How to customize your
workstation environment for CICS for OS/2” on page 23 for information
on ELARUNC.CMD.

3. Sign on to the user ID SYSAD.
4. Run transaction CEDA to create a PCT entry for the IVP program. Use the

following information:
Transaction code VP6P
Group name ELAIVP
Program name ELAIVP6
Description VisualAge Generator Server IVP

TRANSACTION
5. To stop CICS for OS/2, type CQIT.

CQIT will shut down the entire CICS for OS/2 system.
For additional information about the CICS for OS/2 environment, refer to
your CICS for OS/2 documentation.

6. If the environment variable CICSRGRP is being used, add the group name
ELAIVP to CICSRGRP.
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The environment variable CICSRGRP determines which program groups
should be loaded from the CICS for OS/2 resource tables when CICS for
OS/2 starts.
If CICSRGRP is already in use on your workstation, add the group name
ELAIVP to it. If CICSRGRP is not already in use on your workstation, then
the default action taken by CICS for OS/2 is to load all the groups when it
starts. Do not change CICSRGRP in this situation.

7. Start CICS for OS/2 again.
8. Run transaction VP6P.
9. If the VisualAge Generator Server run-time services window appears, the

verification process is complete. Press Enter or any function key to exit the
IVP. If the VisualAge Generator Server run-time services window does not
appear, review the installation steps and install the product again.
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Chapter 11. Uninstalling VisualAge Generator on OS/2

This chapter describes how to uninstall VisualAge Generator Developer,
VisualAge Generator Server, and VisualAge Generator Common Services on
an OS/2 system.

To delete a product do the following:
1. Ensure the product is not running on your workstation.
2. From the VisualAge Generator 4.5 product folder, run the product

installation utility.
3. From the Installation and Maintenance list, select the product.
4. From the Action pull-down menu, select Delete.

The Delete window is displayed.
5. Review the information on the Delete window, and select the components

to be deleted.
6. On the Delete window, click Delete to begin the deletion. When you click

Delete, the following actions take place:
a. The Status changes to Delete – progress.
b. All product package files are deleted from the workstation. Any

backed-up service level files are also deleted.
c. A completion message appears.

7. Close the installation utility.
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Part 3. Installing and uninstalling VisualAge Generator
on Windows

This part describes how to install and uninstall the following products on the
Microsoft Windows platform:
v VisualAge Generator Developer
v VisualAge Generator Server
v VisualAge Generator Common Services

VisualAge Generator Developer must be installed on top of VisualAge
Smalltalk or VisualAge for Java.

Note: If you are running a version of Windows NT before 4.0 Service Pack 4
and your PATH variable is 512 characters or longer, you may not be
able to install VisualAge Generator Common Services, VisualAge
Smalltalk, or VisualAge for Java.

Unless a specific version of Windows NT is referenced, statements regarding
Windows NT also apply to Windows 2000.
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Chapter 12. Installing and customizing VisualAge
Generator Developer for Windows NT

This chapter describes how to install and customize VisualAge Generator
Developer for Windows NT. Unless a specific version of Windows NT is
referenced, statements regarding Windows NT also apply to Windows 2000.
The chapter contains the following information:
v What to do before you install the product
v How to install VisualAge Generator Developer
v How to prepare VisualAge Generator Developer to use DRDA to access a

database
v How to customize VisualAge Generator Developer

Sample applications are also installed with the product. See “Appendix D.
Installing samples for VisualAge Generator Developer on Smalltalk” on
page 117 for more information.

Before you install VisualAge Generator Developer

Before you begin installing VisualAge Generator Developer for Windows NT,
read the sections below for important information about uninstalling previous
products and on hardware and software requirements.

Uninstalling previous products
If you are migrating from a previous version of VisualGen Developer or
VisualAge Generator Developer, delete that version before installing Version
4.5 of VisualAge Generator Developer for Windows NT; then reboot.
Coexistence of Version 4.5 is not supported with any previous version of
VisualGen Developer or VisualAge Generator Developer on the same
workstation. For more information about deleting these products from your
workstation, see “Uninstalling VisualAge Generator Developer for
Windows NT” on page 61.

Hardware and software requirements for VisualAge Generator Developer
Before you begin the installation process, review the hardware and software
requirements at the IBM VisualAge Generator Web site. Go to
http://www.ibm.com/software/ad/visgen and click on the “Hardware and
software requirements” link. The information listed includes requirements for
installing VisualAge Generator Developer for Windows NT.

© Copyright IBM Corp. 1992, 1999, 2000 47



How to install VisualAge Generator Developer

To install VisualAge Generator Developer on Windows NT, do the following:
1. Insert the VisualAge Generator Developer CD into the CD-ROM drive.
2. Wait several seconds for the installation program to start. If it does not

start automatically, in a Windows NT command prompt window run the
following command:
d:\setup.exe

where d is the letter of the CD-ROM drive containing the CD.
3. Follow the instructions on the install screens to complete the installation.
4. The installation of your selected components is now complete. Click on

Exit.

After you install VisualAge Generator Developer, you must load VisualAge
Generator Developer into your image. How you do this depends on whether
VisualAge Generator Developer is loaded on VisualAge for Java or VisualAge
Smalltalk.

Configuring a LAN generation server
To configure a LAN generation server, check the checkbox for “Configure
LAN Generation Server” in the “Setup Type” dialog box during installation.
The automated configuration will later prompt you for a LAN generation
server directory and network type. If your network type is Novell NetWare,
you will also be prompted for a Novell NetWare logon ID and the send
command location. When choosing LAN generation server directory, make
sure that you have full access (read/write) to the directory.

After installation is finished, go to the specified LAN generation directory and
open the efkgensv.ini file. Make sure the directory values are correct. For
detailed information, see the VisualAge Generator Generation Guide.

Loading VAGen into your Java workspace
To install the VisualAge Generator Developer feature:
1. From the Start menu, start VisualAge for Java by selecting Programs→IBM

VisualAge Generator 4.5 →VisualAge Generator Developer on Java.
2. On the Workbench, select File→Quick Start.
3. On the Quick Start dialog, select Features on the left and Add Feature on

the right; then select OK.
4. Select IBM VisualAge Generator 4.5, and click OK. (Loading the feature

will take a few minutes.)
5. Close the Workbench and the Log, if open. You will be prompted to save

the workspace. Click OK to save the workspace.
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Loading VAGen into your Smalltalk image
1. Before starting the image, you should consider saving a copy of the

VisualAge Smalltalk image named abt.icx.
2. From the Start menu, select Programs→IBM VisualAge Smalltalk

Enterprise Client→Development Image to start VisualAge Smalltalk.
3. From the Organizer Options pull-down, select Load/Unload features.
4. On the Selection Required window take the following actions:

a. Make sure the Show other features checkbox is checked.
b. In the Available features pane, select Other: VAGen45 Developer.
c. Select the >> button to move Other: VAGen45 Developer to the

Loaded features pane.
d. If you want to use ITF partitioning, select Other: VAGen45

Partitioning Support.
e. If you want to use GUI settings, select Other: VAGen45 GUI settings.
f. Click OK. VisualAge Generator Developer and, if selected, VisualAge

Generator Developer Partitioning Support and VisualAge Generator
Developer GUI Settings will be imported and loaded into your
workspace. This could take up to two hours to finish.

g. Once VisualAge Generator Developer is loaded, you will be prompted
to save your image. Click the Yes button so you will not have to load
VisualAge Generator Developer the next time you start VisualAge
Smalltalk. The image is saved as file abt.icx by default. After the image
is saved, you might consider making a copy of the image file.

Loading Templates Quickstart into your Java workspace
To install the IBM VisualAge Generator Templates Quickstart feature:
1. From the Start menu, start VisualAge for Java by selecting Programs→IBM

VisualAge Generator 4.5 →VisualAge Generator Developer on Java.
2. On the Workbench, select File→Quick Start.
3. On the Quick Start dialog, select Features on the left and Add Feature on

the right; then select OK.
4. Select IBM VisualAge Generator Templates 4.5, and select OK. (Loading

the feature will take a few minutes.)
5. Close the Workbench, and then close the Log. You will be prompted to

save the workspace. Click OK to save the workspace.

Loading Templates Quickstart into your Smalltalk image
1. Before starting the workspace, you should consider saving a copy of the

VisualAge Smalltalk image named abt.icx.
2. From the Start menu, select Programs→IBM VisualAge Smalltalk

Enterprise Client→Development Image to start VisualAge Smalltalk.
3. From the Organizer Options pull-down, select Load/Unload features.
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4. On the Selection Required window:
a. Make sure the Show other features checkbox is checked.
b. In the Available features pane, select Other: VAGTemplates Quick Start

4.5.
c. Select the >> button to move Other: Templates Quickstart to the

Loaded features pane.
d. Click OK. VisualAge Generator Templates Quickstart will be imported

and loaded into your workspace.
e. Once VisualAge Generator Templates Quickstart is loaded, you will be

prompted to save your image. Click the Yes button so you will not
have to load Templates Quickstart the next time you start VisualAge
Smalltalk. The image is saved as file abt.icx by default. After the image
is saved, you might consider making a copy of the image file.

For more information about installing VisualAge Generator Developer, refer to
the VisualAge Generator System Development Guide.

Preparing VisualAge Generator Developer to use DRDA to access a database

VisualAge Generator Developer uses access plan DEVELOP.xxx when
accessing data from a relational database. The access plan, also known as a
package, is used when developing, testing, and validating VisualAge
Generator programs. When multiple developers are accessing the same
database from VisualAge Generator, they all share the same access plan.
Because of the potential for deadlock situations to occur, it is recommended
that a database administrator performs the following tasks.
1. Creating the VisualAge Generator Collection

The VisualAge Generator access plan, when bound to the database, is
created in a collection called DEVELOP. On most IBM relational database
management systems, this collection is created automatically at bind time.
For DB2/400, the collection, DEVELOP, must first be created by issuing
the following command from the SQL Interactive Session (STRSQL):
CREATE COLLECTION DEVELOP

For the following databases, the collection is created automatically when
the access plan is bound, if you have database administrator authority:
v DB2/MVS
v DB2/VM
v DB2/VSE
v DB2/NT
v DB2/AIX

2. Preparing the access plan
The VisualAge Generator access plan contains some SQL statements that
are not supported by all databases. To account for these differences, you
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need to create the access plan outside of VisualAge Generator. To create
the VisualAge Generator package on the target database system, the
database administrator needs to perform the following steps on the DB2
Connect or DDCS/2 gateway machine:
a. Make sure that the VisualAge Generator bind file HPTDB245.BND is

accessible to the DB2 Connect or DDCS/2 gateway machine.
b. Type the following commands in your DB2 command-line processor

window:
db2 connect to DBNAME user USERID using PASSWORD
db2 bind path\HPTDB245.BND blocking all sqlerror continue messages
vgbind.msg datatime XXX grant public
db2 connect reset

where DBNAME, USERID, and PASSWORD apply to the DRDA server
and xxx is the desired date and time stamp format.

Customizing VisualAge Generator Developer for Windows NT

This section describes how to customize VisualAge Generator Developer for
Windows NT. Before you begin customizing, complete all the appropriate
steps in “How to install VisualAge Generator Developer” on page 48.

By default, the installation utility updates the Windows NT registry with the
VisualAge Generator Developer information. You can further customize your
VisualAge Generator Developer by using the VAGen Options notebook or
Preferences notebook.

Installing MVS support for transferring files
The tasks in this section are needed only if you have variable-length VSAM
files and you need to install the ELACOVTF utility.

Files that contain a file conversion utility, supporting JCL code, and a CLIST,
are included with VisualAge Generator Developer in the product directory.
These files have the following names:

EZERCLS2.DSN
EZERLMD2.DSN
EZERHOST.DSN

To install these files on your MVS host, complete the following steps:
1. Start Personal Communications.
2. Log on to an MVS host session and ensure that you are at a READY

prompt.
3. Transfer the files to the MVS host system by using the following

commands:
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SEND EZERCLS2.DSN A:'EZED30.SEZECLS2.OUTDSN'
SEND EZERLMD2.NLS A:'EZED30.SEZELMD2.OUTDSN'
SEND EZERHOST.NLS A:'EZED30.SEZEHOST.OUTDSN'

where A: is the host session identifier.

Notes:

a. This step assumes you have authority to create MVS data sets with the
EZED30 prefix. If not, specify your user ID instead of EZED30 and
make the appropriate changes to the JCL and CLIST described below.

b. You only need to transfer files if you have variable length VSAM files.
See the VisualAge Generator Server Guide for download procedures. See
the online help for information on how to use the SEND command.

If you are transferring from a DBCS operating system (OS/2J, OS/2H,
OS/2T), you must append a left square bracket ([) at the end of the
command. There should be at least one space between the command and
the left bracket ([).

4. Before the data sets can be used on MVS, you must do a TSO RECEIVE
for each data set, using the INDSN parameter. Type the following
commands:
RECEIVE INDSN('EZED30.SEZECLS2.OUTDSN')
RECEIVE INDSN('EZED30.SEZELMD2.OUTDSN')
RECEIVE INDSN('EZED30.SEZEHOST.OUTDSN')

If you are transferring from a DBCS operating system (OS/2J, OS/2H,
OS/2T), you must append a left square bracket ([) at the end of the
command. There should be at least one space between the command and
the left bracket ([).

For each of these commands you will be prompted for restore parameters.
Specify one of the following commands:
DA('EZED30.SEZECLS2')
DA('EZED30.SEZELMD2')
DA('EZED30.SEZEHOST')

5. After the data sets have been successfully installed on MVS, complete the
following steps:
a. Run the job EZED30.SEZEHOST(EZECJVCL) to create a

variable-blocked CLIST data set.
b. If you use variable-blocked CLISTs, use JCL procedure

EZED30.SEZEHOST(EZECOPRF) to run the EZECOVTF utility.

Note: You can also copy EZED30.SEZEHOST(EZECOPRF) to a
PROCLIB on your system.
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Chapter 13. Installing and customizing VisualAge
Generator Server for Windows NT

This chapter describes how to install and customize VisualAge Generator
Server for Windows NT. It includes the following information:
v What to do before you install the product
v How to install VisualAge Generator Server
v How to customize VisualAge Generator Server

Sample applications are also installed with the product. See “Appendix D.
Installing samples for VisualAge Generator Developer on Smalltalk” on
page 117 for more information.

Before you install VisualAge Generator Server

Before you begin installing VisualAge Generator Server for Windows NT,
read the sections below for important information about uninstalling previous
products and on hardware and software requirements.

Uninstalling previous products
If you have a previous version of VisualGen Workgroup Services, VisualAge
Generator Workgroup Services, or VisualAge Generator Server installed on a
workstation, delete it before installing Version 4.5 of VisualAge Generator
Server for Windows NT. Coexistence of Version 4.5 is not supported with any
previous version of Workgroup Services or VisualAge Generator Server on the
same workstation. For more information about deleting these products from
your workstation, see “Uninstalling VisualAge Generator Server for
Windows NT” on page 61.

Hardware and software requirements for VisualAge Generator Server
Before you begin the installation process, review the hardware and software
requirements at the IBM VisualAge Generator Web site. Go to
http://www.ibm.com/software/ad/visgen and click on the “Hardware and
software requirements” link. The information listed includes requirements for
installing VisualAge Generator Server for Windows NT and for running
generated programs.
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How to install VisualAge Generator Server

To install VisualAge Generator Server for Windows NT, do the following:
1. Insert the VisualAge Generator Server CD into the CD-ROM drive.
2. On your Windows NT system run the following command:

d:\setup.exe

where d: is the CD-ROM drive containing the CD.
3. Follow the instructions on the install screens to complete the installation.
4. The installation of your selected components is now complete. Click on

Exit to close the installation program.

Customizing VisualAge Generator Server for Windows NT

The environment variables listed below are used by VisualAge Generator
Server for Windows NT. You can add them or modify them by changing the
System settings in the Control Panel in the Windows NT environment or by
editing the environment file for the CICS for Windows NT environment.

Table 4 provides a summary of the environment variables used by
Windows NT. For a complete description of the environment variables, see
“Appendix A. Environment variable values” on page 89.

Table 4. Environment variables

Environment variable Required Optional

CSODIR X

CSOTROPT X

CSOTROUT X

DB2INSTANCE¹ X

EZERJULS_xxx X

EZERJULL_xxx X

EZERGRGS_xxx X

EZERGRGL_xxx X

EZERNLS X

EZERSQLDB X

FCWDBNAME_progname X

FCWDBNOOP X

FCWDBPASSWORD X

FCWDBUSER X

FCWDBVERSION X²
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Table 4. Environment variables (continued)

Environment variable Required Optional

FCWDPATH X

FCWMAKE X

FCWRSC X

FCWTROPT X

FCWTROUT X

Note: ¹This environment variable is required only if you are using DB2, ODBC, or
Oracle.
Note: ²This environment variable is required only if you are using Oracle.

Additional customization for CICS for Windows NT
To enable CICS for Windows NT VisualAge Generator Server support,
additional customization tasks are required.

VisualAge Generator Server for Windows NT programs, transactions, and
other definitions must be added to the CICS for Windows NT permanent and
run-time databases. A batch file fcwcicsinstall.bat is provided to add these
default definitions to the permanent database. You can use this shell script as
a template for creating customized definitions. Run the following commands
for each CICS for Windows NT regions, which will support VisualAge
Generator Server for Windows NT:

fcwcicsinstall

You must also add the environmental variables LIBPATH, FCWDPATH, and
EZERNLS to each CICS for Windows NT region’s environment file as shown
in the following example:

EZERNLS=ENU
PATH=c:\genout
FCWDPATH=c:\genout

LIBPATH and FCWDPATH identifies the directories where program maps and
tables can be located by a CICS for Windows NT program. The user
associated with the CICS for Windows NT program processes must have
authority to access these directories.

Customizing VisualAge Generator Server run-time messages for
Windows NT and CICS for Windows NT

Run-time messages report that a condition that is not handled by a program
has occurred. These messages can be modified to provide more information to
the user.
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Error messages that are used by the generated C++ programs provided with
VisualAge Generator Server are stored in the FCWxxx.TAB file. This file
contains default messages that should be acceptable for most situations.

If you elect to customize these messages, do the following:
1. Import the external source format source information containing the

VisualAge Generator Server error messages into a target ENVY
application.
This external source format information is available as FCWxxx.ESF on the
workstation in the C:\IBMVAGen\vgwgs45 directory.

Note: The xxx refers to the language version. See “VisualAge Generator
Server national language support” on page 110 for a listing of the
language codes.

2. Use the VisualAge Generator Developer Table Editor to change the
message text, which is in the second column in the table.
Ensure that you do not modify anything other than the second column.
The order of message inserts can change, but the number and format
specifications for the message inserts must not be changed.
A message insert appears as the following string format in the message
text:
%nn

nn Specifies the relative position of the text string to be substituted
for the insert, such as 01 for the first text string or 02 for the
second

3. Using VisualAge Generator Developer, generate a new message table for
the Windows NT environment. A file with the name FCWxxx.TAB should
be created.

Note: The xxx refers to the language version. See “VisualAge Generator
Server national language support” on page 110 for a listing of the
language codes.

4. Make a backup copy of the current message files.
The message files are located in the C:\IBMVAGen\vgwgs45 directory.
There should be two message files for each national language installed,
FCWxxx.TAB and FCWxxx.ESF.

5. Delete the existing message files.
6. Copy the new message files into the appropriate location.
7. Your customized message table will be in effect the next time you start

CICS for Windows NT or run a VisualAge Generator program in
Windows NT.
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Installing VisualAge Generator Server for Java

VisualAge Generator Server for Java comprises two JAR files (hpt.jar,
vgjwgs.jar) and a properties file (vgj.properties). The JAR files contain a set of
Java classes that provide run-time support for generated 4GL Java parts. The
properties file defines the run-time behavior of the generated code.

You can install VisualAge Generator Server for Java from the VisualAge
Generator V4.5 installation CD by selecting the VisualAge Generator V4.5 –
Server component. The default root directory for the component installation is
C:\IBMVAGen. During installation you can specify a different directory, if you
wish.

During installation, the following files are copied from the installation image:

hpt.jar Contains the VG Java run-time code that is necessary to run a
generated VG Java program. By default it is copied to the
C:\IBMVAGen\VGCSO45 directory.

vgjwgs.jar Contains the VAGen Java run-time code that is necessary to
run a generated VisualAge for Java server program. By default
it is copied to the C:\IBMVAGen\VGWGS45 directory.

vgj.properties Defines the environment settings used in place of environment
variables for the VG Java run-time library. By default it is
copied to the C:\IBMVAGen\VGCSO45 directory.

To run a generated 4GL Java program, the JVM must know how to find the
run-time library. Java applications need the CLASSPATH environment variable
to include the location of these .JAR files and the properties file, or the
directory where the class files are stored if they have been extracted from the
JAR file. Java applets have the same requirement, but they get the information
from the ARCHIVE or CODEBASE parameters of the HTML tag.

VisualAge Generator Server for Java uses vgj.properties to configure its
run-time environment. For VisualAge Generator Server to access the
properties file, the CLASSPATH environment variable or the CODEBASE
HTML tag needs to include the root directory where the properties file is
installed. The CLASSPATH is updated during installation.

Setting up the environment
These steps only need to be performed once. They must be done before you
can run your programs outside VisualAge for Java.
1. Install the VisualAge Generator Server component on your system. The

CLASSPATH will be set during installation.
2. Customize vgj.properties as required for your environment. Comments in

the file describe what effect the properties have on programs as they run.
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3. Install your JVM.
If you want to run applets, you need a web browser or the appletviewer
program that comes with the JDK and JRE.
If you want to run applications, you need a program like java.exe that
comes with the JDK or jre.exe that comes with the JRE.

Notes: You need a JVM that runs version 1.2 of Java or higher and a Web
browser that supports this version.

Sun’s JDK can be downloaded from:
http://java.sun.com/products/jdk/1.2

Sun’s JRE can be downloaded from:
http://java.sun.com/products/jdk/1.2/jre

The Web browser you use must support Java version 1.2 or later.
The most recent version of Netscape and Internet Explorer (IE)
may support this version of Java. You can also use the HotJava
browser instead of Netscape or IE. HotJava is written in Java and
will run on any system with Java version 1.1.6 or later installed.

HotJava can be downloaded from:
http://www.javasoft.com/products/hotjava/index.html

If you must use Netscape or IE, you can use the Java plug-in that
is included with the JDK and JRE. Under this configuration,
instead of the browser running your applet, the plug-in runs it
using a newer version of the JVM.

4. If you want to run applications, you need to set your CLASSPATH
environment variable.
The CLASSPATH variable is used to tell the JVM running an application
where the application’s code is. CLASSPATH is a list of directories, Jar
files, and Zip files.
On Windows, each entry in CLASSPATH is separated by a semicolon.
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Chapter 14. Installing VisualAge Generator Common
Services on Windows

This chapter includes information needed to install VisualAge Generator
Common Services on Windows 2000, Windows NT, Windows 98, and
Windows 95. It includes the following information:
v What to do before you install the product
v How to install VisualAge Generator Common Services

Sample applications are also installed with the product. See “Appendix D.
Installing samples for VisualAge Generator Developer on Smalltalk” on
page 117 for more information.

Before you install VisualAge Generator Common Services

Before you begin installing VisualAge Generator Common Services for
Windows NT, read the sections below for important information about
uninstalling previous products, installing related products, and getting a list
of hardware and software requirements.

Uninstalling previous products
If you have a previous version of VisualGen Common Services or VisualAge
Generator Common Services installed on a workstation, delete it before
installing Version 4.5 of VisualAge Generator Common Services for
Windows NT. Coexistence of Version 4.5 is not supported with any previous
version of Common Services on the same workstation. For more information
about deleting these products from your workstation, see “Uninstalling
VisualAge Generator Common Services on Windows” on page 61.

Installing related products
VisualAge Generator Common Services is required to run GUI clients. It is
also required to run VisualAge Generator Developer and VisualAge Generator
Server. VisualAge Generator Common Services is installed automatically when
you install VisualAge Generator Developer or VisualAge Generator Server.

Hardware and software requirements for VisualAge Generator Common
Services

VisualAge Generator Common Services is required to run GUI clients. It is
also required to run VisualAge Generator Developer and VisualAge Generator
Server. You can install VisualAge Generator Common Services before or after
you install VisualAge Generator Developer or VisualAge Generator Server, but
it must be installed before you use either of those two products.
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Before you begin the installation process, review the hardware and software
requirements at the IBM VisualAge Generator Web site. Go to
http://www.ibm.com/software/ad/visgen and click on the “Hardware and
software requirements” link. The information listed includes requirements for
installing VisualAge Generator Common Services for Windows.

How to install VisualAge Generator Common Services

If you want to install only VisualAge Generator Common Services, take the
following actions:
1. Insert into the CD-ROM drive the compact disk for VisualAge Generator

Developer (on Java or Smalltalk) or for VisualAge Generator Server.
2. Exit from the automatically started installation.
3. Run the following command:

d:\cso\setup.exe

where d is the letter of the CD-ROM drive containing the CD.
4. Follow the instructions on the install screens to complete the installation.
5. The installation of your selected components is now complete. Click on

Exit to close the installation program.
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Chapter 15. Uninstalling VisualAge Generator on Windows

This chapter includes information needed to uninstall VisualAge Generator on
Microsoft Windows platforms.

Uninstalling VisualAge Generator Developer for Windows NT

To uninstall VisualAge Generator Developer for Windows NT 4.0, complete
the following steps:
1. From the Start menu, select Control Panel → Add/Remove Programs.
2. Select VisualAge Generator Developer.
3. Click on Remove.

Uninstalling VisualAge Generator Server for Windows NT

To uninstall VisualAge Generator Server for Windows NT 4.0, complete the
following steps:
1. From the Start menu, select Control Panel → Add/Remove Programs.
2. Select VisualAge Generator Server.
3. Click on Remove.

Uninstalling VisualAge Generator Common Services on Windows

If you uninstall both VisualAge Generator Developer and VisualAge
Generator Server, or if you uninstall one and the other is not installed,
VisualAge Generator Common Services is automatically uninstalled.

To uninstall VisualAge Generator Common Services manually on Windows
2000, Windows NT 4.0, Windows 98, and Windows 95, complete the
following steps:
1. From the Start menu, select Control Panel → Add/Remove Programs.
2. Select VisualAge Generator Common Services.
3. Click on Remove.
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Part 4. Installing and uninstalling VisualAge Generator
Server on UNIX

This part describes how to install and uninstall VisualAge Generator Server
on the following platforms:
v AIX
v HP-UX
v SCO OpenServer
v Solaris
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Chapter 16. Installing and customizing VisualAge
Generator Server for AIX

This chapter describes the installation process and how to install and
customize VisualAge Generator Server for AIX. It includes the following
information:
v Before you install
v Installing VisualAge Generator Server for AIX
v Customizing VisualAge Generator Server for AIX

Sample applications are also installed with the product. For more information,
see “Appendix D. Installing samples for VisualAge Generator Developer on
Smalltalk” on page 117.

Before you install

Before you begin the installation process, review the hardware and software
requirements at the IBM VisualAge Generator Web site:
http://www.ibm.com/software/ad/visgen

The information listed includes requirements for installing VisualAge
Generator Server for AIX and for running generated programs.

Installing VisualAge Generator Server for AIX

This section describes the preparation necessary to install VisualAge Generator
Server for AIX from the CD and how to install VisualAge Generator Server for
AIX. VisualAge Generator Server for AIX is shipped in standard installp
format on a CD. To install VisualAge Generator Server for AIX from the CD,
the system administrator must perform the steps in the following sections.

Adding a CD-ROM file system
To add a CD-ROM file system, do the following:

1. Insert the VisualAge Generator Server for AIX CD into the CD-ROM
drive.

2. Log in to your AIX machine as user root or run su to become root.
3. Enter mkdir -p /usr/cdrom

4. Enter smit storage
5. Select File Systems
6. Select Add/Change/Show/Delete File Systems
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7. Select CDROM File Systems
8. Select Add a CDROM File System
9. Select a DEVICE name. CD-ROM file system device names must be

unique.
10. Type /usr/cdrom for MOUNT POINT
11. Select Do (or press enter if using the SMIT ASCII interface)
12. Exit SMIT.

Mounting the CD-ROM file system
To mount the CD-ROM, do the following:
1. Enter smit mountfs
2. Select /dev/cd0 (or /dev/cd1) for FILE SYSTEM name.
3. Select /usr/cdrom for DIRECTORY over which to mount.
4. Select cdrfs for TYPE of file system.
5. Select yes for Mount as a READ-ONLY system.
6. Select Do (or press enter if using the SMIT ASCII interface).
7. Exit SMIT.

Installing the image
To install VisualAge Generator Server for AIX, take the following actions:
1. Insert the VisualAge Generator Server for AIX CD into the CD-ROM drive.
2. From an AIX shell command prompt, install the base plus the English

language parts, as shown in Table 5.

Table 5. Image files shipped with VisualAge Generator Server for AIX

Image file System Command

vgaix45.img AIX installp -ad /usr/cdrom/aix/base/vgaix45.img all

vgaix45t.img CICS for AIX installp -ad /usr/cdrom/aix/base/vgaix45t.img all

3. To install a language other than English, enter the following:
installp -ad /usr/cdrom/aix/xxx/vgwgs45y.img all

where xxx is the three-character NLS code and y is the one-character NLS
code. For information on the NLS codes see “VisualAge Generator Server
national language support” on page 110.

4. Due to performance enhancements provided in Version 4.5 of VisualAge
Generator Server for AIX, it is now necessary to run the vglinks script (in
the bin directory of the VisualAge Generator Server for AIX product
installation directory) after you install VisualAge Generator Server. This
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script creates symbolic links in the /usr/lib system directory to all the
VisualAge Generator Server libraries. Install these symbolic links as
follows:
a. Log in to your AIX machine as user root or run su to become root.
b. Change your current working directory to /usr/lpp/vgwgs45.
c. Run the vglinks script as follows:

./vglinks

or, to overwrite existing links (to force creation):
./vglinks -f

For more information on using installp for installing software products, refer
to your AIX documentation.

Customizing VisualAge Generator Server for AIX

The following environment variables are used by VisualAge Generator Server
for AIX and must be added to your .profile file for the native AIX
environment or the environment file for the CICS for AIX environment. The
CICS for AIX environment file is located in the
/var/cics_regions/$CICSREGION directory.

Table 6 provides a summary of the environment variables used by AIX. For a
complete description of the environment variables, see “Appendix A.
Environment variable values” on page 89.

Table 6. Environment variables

Environment variable Required Optional

CSODIR X

CSOTROPT X

CSOTROUT X

DB2INSTANCE¹ X

EZERJULS_xxx X

EZERJULL_xxx X

EZERGRGS_xxx X

EZERGRGL_xxx X

EZERNLS X

EZERSQLDB X

FCWDB2DIR X¹

FCWDBNAME_progname X

FCWDBNOOP X
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Table 6. Environment variables (continued)

Environment variable Required Optional

FCWDBPASSWORD X

FCWDBUSER X

FCWDPATH X

FCWFIODB X

FCWLIBPATH X

FCWRSC X

FCWTROPT X

FCWTROUT X

Note: ¹This environment variable is required only if you are using DB2 for AIX.

Additional customization for CICS for AIX
To enable CICS for AIX VisualAge Generator Server support, additional
customization tasks are required.

VisualAge Generator Server for AIX programs, transactions, and other
definitions must be added to the CICS for AIX permanent and run-time
databases. Shell script fcwcicsinstall is provided to add these default
definitions to the permanent database. You can use this shell script as a
template for creating customized definitions. Run the following commands for
each CICS for AIX regions, which will support VisualAge Generator Server for
AIX:

export CICSREGION=aixcics
fcwcicsinstall
cicsinstall -r aixcics -g VGWGS

You must also add the environmental variables FCWLIBPATH, FCWDPATH,
and EZERNLS to each CICS for AIX region’s environment file as shown in the
following example:

EZERNLS=ENU
FCWLIBPATH=/u/mitch/genout:/u/mary/genout
FCWDPATH=/u/mitch/genout:/u/mary/genout
LIBPATH=/usr/lib:/lib:/usr/lpp/vgwgs45/lib

FCWLIBPATH and FCWDPATH identify the directories where program maps
and tables can be located by a CICS for AIX program. The user associated
with the CICS for AIX program processes must have authority to access these
directories.
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Customizing VisualAge Generator Server run-time messages for AIX and
CICS for AIX

Run-time messages report that a condition that is not handled by a program
has occurred. These messages can be modified to provide more information to
the user.

Error messages that are used by the generated C++ programs provided with
VisualAge Generator Server are stored in the fcwxxx.tab file. This file contains
default messages that should be acceptable for most situations.

If you elect to customize these messages, do the following:
1. Import the external source format source information containing the

VisualAge Generator Server error messages into a target ENVY
application.
This external source format information is available as fcwxxx.esf in the
/usr/lpp/vgwgs45 directory.

Note: The xxx refers to the language version. For a listing of the language
codes, see “VisualAge Generator Server national language support”
on page 110.

2. Use the VisualAge Generator Developer table definition facility to change
the message text, which is in the second column in the table.
Ensure that you do not modify anything other than the second column.
The order of message inserts can change, but the number and format
specifications for the message inserts must not be changed.
A message insert appears as the following string format in the message
text:
%nn

nn Specifies the relative position of the text string to be substituted for the
insert, such as 01 for the first text string or 02 for the second

3. Using VisualAge Generator Developer, generate a new message table for
the AIX environment. A file with the name fcwxxx.tab should be created.

Note: The xxx refers to the language version. For a listing of the language
codes, see “VisualAge Generator Server national language support”
on page 110.

4. Make a backup copy of the current message table files.
The message table files are located in the /usr/lpp/vgwgs45 directory.
There should be two message table files for each national language
installed, fcwxxx.tab and fcwxxx.esf.

5. Delete the existing message table files.
6. Copy the new message table files into the appropriate location.
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7. Your customized message table will be in effect the next time you run a
VisualAge Generator program (native AIX) or start CICS for AIX.
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Chapter 17. Installing and customizing VisualAge
Generator Server for HP-UX

This chapter describes how to install and customize VisualAge Generator
Server for HP-UX. It includes the following information:
v Before you install
v Installing VisualAge Generator Server for HP-UX
v Customizing VisualAge Generator Server for HP-UX

Sample applications are also installed with the product. For more information,
see “Appendix D. Installing samples for VisualAge Generator Developer on
Smalltalk” on page 117.

Before you install

Before you begin the installation process, review the hardware and software
requirements at the IBM VisualAge Generator Web site:
http://www.ibm.com/software/ad/visgen

The information listed includes requirements for installing VisualAge
Generator Server for HP-UX and for running generated programs.

Installing VisualAge Generator Server for HP-UX

This section describes how to install VisualAge Generator Server for HP-UX.
VisualAge Generator Server for HP-UX is shipped in standard tar format on a
CD created with the Portable File System type of ISO 9660.

To install VisualAge Generator Server for HP-UX, do the following:
1. Log in to your HP-UX machine as user root or run su to become root.
2. Enter mkdir -p /cdrom

3. Insert the CD into the CD-ROM drive
4. Start the pfs_mounted server program (if not already running) as follows:

nohup /usr/sbin/pfs_mounted &

5. Start the pfsd server program (if not already running) as follows:
nohup /usr/sbin/pfsd &

6. Use a system editor to add the following line to the /etc/pfs_fstab file:
/dev/dsk/c1t2d0 /cdrom pfs-iso9660 xlat=unix 0 0
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Note: The device file name (/dev/dsk/c1t2d0) might be different on your
system. Specify a valid CD-ROM device file name for your system
that corresponds to the CD-ROM drive where you inserted the
visualAge Generator CD.

7. Mount the CD-ROM as follows:
usr/sbin/pfs_mount /cdrom

8. Change your current working directory to the /opt directory.
9. Install the base product plus the English language parts as shown in

Table 7.

Table 7. Tar files shipped with VisualAge Generator Server for HP-UX

Tar file System Command

vghp45.tar HP-UX Version 10.20 tar -xvf /cdrom/hp/base/vghp45.tar

10. To install a language other than English, enter the following:
tar -xvf /cdrom/hp/xxx/vgwgs45y.tar

where xxx is the three-character NLS code and y is the one-character NLS
code. For information on the NLS codes, see “VisualAge Generator Server
national language support” on page 110.

11. Due to performance enhancements provided in Version 4.5 of VisualAge
Generator Server for HP-UX, it is now necessary to run the vglinks script
(in the bin directory of the VisualAge Generator Server for HP-UX
product installation directory) after you install VisualAge Generator
Server. This script creates symbolic links in the /usr/lib system directory
to all the VisualAge Generator Server libraries. Install these symbolic
links as follows:
a. Log in to your HP-UX machine as user root or run su to become root.
b. Change your current working directory to /opt/vgwgs45.
c. Run the vglinks script as follows:

./vglinks

or, to overwrite existing links (to force creation):
./vglinks -f

Refer to your HP-UX documentation for more information on using the tar
command.

Customizing VisualAge Generator Server for HP-UX

The following environment variables are used by VisualAge Generator Server
for HP-UX and must be added to your .profile file.
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For a complete description of the environment variables, see “Appendix A.
Environment variable values” on page 89.

Table 8 provides a summary of the environment variables used by HP-UX.

Table 8. Environment variables

Environment variable Required Optional

CSODIR X

CSOTROPT X

CSOTROUT X

DB2INSTANCE¹ X

EZERJULS_xxx X

EZERJULL_xxx X

EZERGRGS_xxx X

EZERGRGL_xxx X

EZERNLS X

EZERSQLDB X

FCWDB2DIR X¹

FCWDBNAME_progname X

FCWDBPASSWORD X

FCWDBUSER X

FCWDPATH X

FCWLIBPATH X

FCWRSC X

FCWTROPT X

FCWTROUT X

Note: ¹This environment variable is required only if you are using DB2 for HP-UX.

Customizing VisualAge Generator Server run-time messages for HP-UX
Run-time messages report that a condition that is not handled by a program
has occurred. These messages can be modified to provide more information to
the user.

Error messages that are used by the generated C++ programs provided with
VisualAge Generator Server are stored in the fcwxxx.tab file. This file contains
default messages that should be acceptable for most situations.

If you elect to customize these messages, do the following:
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1. Import the external source format source information containing the
VisualAge Generator Server error messages into a target ENVY
application.
This external source format information is available as fcwxxx.esf in the
/opt/vgwgs45 directory.

Note: The xxx refers to the language version. For a listing of the language
codes, see “VisualAge Generator Server national language support”
on page 110.

2. Use the VisualAge Generator Developer table definition facility to change
the message text, which is in the second column in the table.
Ensure that you do not modify anything other than the second column.
The order of message inserts can change, but the number and format
specifications for the message inserts must not be changed.
A message insert appears as the following string format in the message
text:
%nn

nn Specifies the relative position of the text string to be substituted for the
insert, such as 01 for the first text string or 02 for the second

3. Using VisualAge Generator Developer, generate a new message table for
the HP-UX environment. A file with the name fcwxxx.tab should be
created.

Note: The xxx refers to the language version. For a listing of the language
codes, see “VisualAge Generator Server national language support”
on page 110.

4. Make a backup copy of the current message table files.
The message table files are located in the /opt/vgwgs45 directory. There
should be two message table files for each national language installed,
fcwxxx.tab and fcwxxx.esf.

5. Delete the existing message table files.
6. Copy the new message table files into the appropriate location.
7. Your customized message table will be in effect the next time you run a

VisualAge Generator program.
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Chapter 18. Installing and customizing VisualAge
Generator Server for SCO OpenServer

This chapter describes how to install and customize VisualAge Generator
Server for SCO OpenServer. It includes the following information:
v Before you install
v Installing VisualAge Generator Server for SCO OpenServer
v Customizing VisualAge Generator Server for SCO OpenServer

Sample applications are also installed with the product. For more information,
see “Appendix D. Installing samples for VisualAge Generator Developer on
Smalltalk” on page 117.

Before you install

Before you begin the installation process, review the hardware and software
requirements . at the IBM VisualAge Generator Web site:
http://www.ibm.com/software/ad/visgen

The information listed includes requirements for installing VisualAge
Generator Server for SCO OpenServer and for running generated programs.

Installing VisualAge Generator Server for SCO OpenServer

This section describes how to install VisualAge Generator Server for SCO
OpenServer. VisualAge Generator Server for SCO OpenServer is shipped in
standard tar format on a CD created with the Portable File System type of ISO
9660.

To install VisualAge Generator Server for SCO OpenServer, do the following:
1. Log in to your SCO machine as user root or run su to become root.
2. Mount the CD-ROM as follows:

mount -r -f HS -o lower /dev/cd0/cdrom

3. Change your current working directory to the /opt directory.
4. Install the base product plus the English language parts as shown in

Table 9 on page 76.
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Table 9. Tar files shipped with VisualAge Generator Server for SCO OpenServer

Tar file System Command

vgsco45.tar SCO OpenServer Version 5.0.4 tar -xvf /cdrom/sco/base/vgsco45.tar

5. To install a language other than English, enter the following:
tar -xvf /cdrom/sco/xxx/vgwgs45y.tar

where xxx is the three-character NLS code and y is the one-character NLS
code. For information on the NLS codes, see “VisualAge Generator Server
national language support” on page 110.

6. Due to performance enhancements provided in Version 4.5 of VisualAge
Generator Server for SCO OpenServer, it is now necessary to run the
vglinks script (in the bin directory of the VisualAge Generator Server for
SCO OpenServer product installation directory) after you install VisualAge
Generator Server. This script creates symbolic links in the /usr/lib system
directory to all the VisualAge Generator Server libraries. Install these
symbolic links as follows:
a. Log in to your SCO machine as user root or run su to become root.
b. Change your current working directory to /opt/vgwgs45.
c. Run the vglinks script as follows:

./vglinks

or, to overwrite existing links (to force creation):
./vglinks -f

For more information on using the tar command, refer to your SCO
OpenServer documentation.

Customizing VisualAge Generator Server for SCO OpenServer

The following environment variables are used by VisualAge Generator Server
for SCO OpenServer and must be added to your .profile file.

Table 10 provides a summary of the environment variables used by SCO
OpenServer. For a complete description of the environment variables, see
“Appendix A. Environment variable values” on page 89.

Table 10. Environment variables

Environment variable Required Optional

CSODIR X

CSOTROPT X

CSOTROUT X
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Table 10. Environment variables (continued)

Environment variable Required Optional

EZERJULS_xxx X

EZERJULL_xxx X

EZERGRGS_xxx X

EZERGRGL_xxx X

EZERNLS X

FCWDPATH X

FCWLIBPATH X

FCWRSC X

FCWTROPT X

FCWTROUT X

Customizing VisualAge Generator Server run-time messages for SCO
OpenServer

Run-time messages report that a condition that is not handled by a program
has occurred. These messages can be modified to provide more information to
the user.

Error messages that are used by the generated C++ programs provided with
VisualAge Generator Server are stored in the fcwxxx.tab file. This file contains
default messages that should be acceptable for most situations.

If you elect to customize these messages, do the following:
1. Import the external source format source information containing the

VisualAge Generator Server error messages into a target ENVY
application.
This external source format information is available as fcwxxx.esf in the
/opt/vgwgs45 directory.

Note: The xxx refers to the language version. For a listing of the language
codes, see “VisualAge Generator Server national language support”
on page 110.

2. Use the VisualAge Generator Developer table definition facility to change
the message text, which is in the second column in the table.
Ensure that you do not modify anything other than the second column.
The order of message inserts can change, but the number and format
specifications for the message inserts must not be changed.
A message insert appears as the following string format in the message
text:
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%nn

nn Specifies the relative position of the text string to be substituted for the
insert, such as 01 for the first text string or 02 for the second

3. Using VisualAge Generator Developer, generate a new message table for
the SCO environment. A file with the name fcwxxx.tab should be created.

Note: The xxx refers to the language version. For a listing of the language
codes, see “VisualAge Generator Server national language support”
on page 110.

4. Make a backup copy of the current message table files.
The message table files are located in the /opt/vgwgs45 directory. There
should be two message table files for each national language installed,
fcwxxx.tab and fcwxxx.esf.

5. Delete the existing message table files.
6. Copy the new message table files into the appropriate location.
7. Your customized message table will be in effect the next time you run a

VisualAge Generator program.
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Chapter 19. Installing and customizing VisualAge
Generator Server for Solaris

This chapter describes how to install and customize VisualAge Generator
Server for Solaris. It includes the following information:
v Before you install
v Installing VisualAge Generator Server for Solaris
v Customizing VisualAge Generator Server for Solaris

Sample applications are also installed with the product. For more information,
see “Appendix D. Installing samples for VisualAge Generator Developer on
Smalltalk” on page 117.

Before you install

Before you begin the installation process, review the hardware and software
requirements at the IBM VisualAge Generator Web site:
http://www.ibm.com/software/ad/visgen

The information listed includes requirements for installing VisualAge
Generator Server for SCO OpenServer and for running generated programs.

Installing VisualAge Generator Server for Solaris

This section describes how to install VisualAge Generator Server for Solaris.
VisualAge Generator Server for Solaris is shipped in standard tar format on a
CD created with the Portable File System type of ISO 9660.

To install VisualAge Generator Server for Solaris, do the following:
1. Log in to your Solaris machine as user root or run su to become root.
2. Enter mkdir /cdrom

3. Mount the CD-ROM as follows:

Note: The device file name (/dev/dsk/c0t6d0s0) might be different on
your system. Specify a valid CD-ROM device file name for your
system that corresponds to the CD-ROM drive where you inserted
the VisualAge Generator CD.

mount -rF hsfs /dev/dsk/c0t6d0s0 /cdrom

4. Change your current working directory to the /opt directory.
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5. Install the base product plus the English language parts as shown in
Table 11.

Table 11. Tar files shipped with VisualAge Generator Server for Solaris

Tar file System Command

vgsol45t.tar Solaris Version 2.6 tar -xvf /cdrom/solaris/base/vgsol45t.tar

6. To install a language other than English, enter the following:
tar -xvf /cdrom/solaris/xxx/vgwgs45y.tar

where xxx is the three-character NLS code and y is the one-character NLS
code. For information on the NLS codes see “VisualAge Generator Server
national language support” on page 110.

7. Due to performance enhancements provided in Version 4.5 of VisualAge
Generator Server for Solaris, it is now necessary to run the vglinks script
(in the bin directory of the VisualAge Generator Server for Solaris product
installation directory) after you install VisualAge Generator Server. This
script creates symbolic links in the /usr/lib system directory to all the
VisualAge Generator Server libraries. Install these symbolic links as
follows:
a. Log in to your Solaris machine as user root or run su to become root.
b. Change your current working directory to /opt/vgwgs45.
c. Run the vglinks script as follows:

./vglinks

or, to overwrite existing links (to force creation):
./vglinks -f

For more information about using the tar command, refer to your Solaris
documentation.

Customizing VisualAge Generator Server for Solaris

The following environment variables are used by VisualAge Generator Server
for Solaris and must be added to your .profile file.

Table 12 provides a summary of the environment variables used by Solaris.
For a complete description of the environment variables, see “Appendix A.
Environment variable values” on page 89.

Table 12. Environment variables

Environment variable Required Optional

CSODIR X
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Table 12. Environment variables (continued)

Environment variable Required Optional

CSOTROPT X

CSOTROUT X

DB2INSTANCE¹ X

EZERJULS_xxx X

EZERJULL_xxx X

EZERGRGS_xxx X

EZERGRGL_xxx X

EZERNLS X

EZERSQLDB X

FCWDB2DIR X¹

FCWDBNAME_progname X

FCWDBNOOP X

FCWDBPASSWORD X

FCWDBUSER X

FCWDPATH X

FCWLIBPATH X

FCWRSC X

FCWTROPT X

FCWTROUT X

Note: ¹This environment variable is required only if you are using DB2 for Solaris.

Customizing VisualAge Generator Server run-time messages for Solaris
Run-time messages report that a condition that is not handled by a program
has occurred. These messages can be modified to provide more information to
the user.

Error messages that are used by the generated C++ programs provided with
VisualAge Generator Server are stored in the fcwxxx.tab file. This file contains
default messages that should be acceptable for most situations.

If you elect to customize these messages, do the following:
1. Import the external source format source information containing the

VisualAge Generator Server error messages into a target ENVY
application.
This external source format information is available as fcwxxx.esf in the
/opt/vgwgs45 directory.
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Note: The xxx refers to the language version. For a listing of the language
codes, see “VisualAge Generator Server national language support”
on page 110.

2. Use the VisualAge Generator Developer table definition facility to change
the message text, which is in the second column in the table.
Ensure that you do not modify anything other than the second column.
The order of message inserts can change, but the number and format
specifications for the message inserts must not be changed.
A message insert appears as the following string format in the message
text:
%nn

nn Specifies the relative position of the text string to be substituted for the
insert, such as 01 for the first text string or 02 for the second

3. Using VisualAge Generator Developer, generate a new message table for
the Solaris environment. A file with the name fcwxxx.tab should be
created.

Note: The xxx refers to the language version. For a listing of the language
codes, see “VisualAge Generator Server national language support”
on page 110.

4. Make a backup copy of the current message table files.
The message table files are located in the /opt/vgwgs45 directory. There
should be two message table files for each national language installed,
fcwxxx.tab and fcwxxx.esf.

5. Delete the existing message table files.
6. Copy the new message table files into the appropriate location.
7. Your customized message table will be in effect the next time you run a

VisualAge Generator program.
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Chapter 20. Uninstalling VisualAge Generator Server on
UNIX

This chapter describes how to uninstall VisualAge Generator Server on the
following platforms:
v AIX
v HP-UX
v SCO OpenServer
v Solaris

Uninstalling VisualAge Generator Server for AIX

On AIX Version 4.1, products successfully installed are always in the
committed state. To remove VisualAge Generator Server from your system,
type the following command:

installp -u vgwgs45.obj

To remove one of the national languages from your system, modify the
command syntax to specify the language. For example, the following
command removes the Japanese version of the product:

installp -u vgwgs45Ja_JP.obj

To uninstall the symbolic links created by the vglinks script during
installation, do the following steps:
1. Log in to your AIX machine as user root or run su to become root.
2. Change your current working directory to /usr/lpp/vgwgs45.
3. Run the following vglinks script and follow the on-screen directions:

./vglinks -r

or, to remove existing links without confirmation (to force deletion):
./vglinks -r -f

Uninstalling VisualAge Generator Server for HP-UX

To uninstall VisualAge Generator Server for HP-UX, do the following steps:
1. Log in to your HP-UX machine as user root or su to root
2. Uninstall the VisualAge Generator Server product (base and languages)

from your system by using the following command:
rm -rf /opt/vgwgs45
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To uninstall the symbolic links created by the vglinks script during
installation, do the following steps:
1. Log in to your HP-UX machine as user root or run su to become root.
2. Change your current working directory to /opt/vgwgs45.
3. Run the following vglinks script and follow the on-screen directions:

./vglinks -r

or, to remove existing links without confirmation (to force deletion):
./vglinks -r -f

Uninstalling VisualAge Generator Server for SCO OpenServer

To uninstall VisualAge Generator Server for SCO OpenServer, do the
following steps:
1. Log in to your SCO machine as user root or su to root
2. Uninstall the VisualAge Generator Server product (base and languages)

from your system by using the following command:
rm -rf /opt/vgwgs45

To uninstall the symbolic links created by the vglinks script during
installation, do the following steps:
1. Log in to your SCO machine as user root or run su to become root.
2. Change your current working directory to /opt/vgwgs45.
3. Run the following vglinks script and follow the on-screen directions:

./vglinks -r

or, to remove existing links without confirmation (to force deletion):
./vglinks -r -f

Uninstalling VisualAge Generator Server for Solaris

To uninstall VisualAge Generator Server for Solaris, do the following steps:
1. Log in to your Solaris machine as user root or su to root
2. Uninstall the VisualAge Generator Server product (base and languages)

from your system by using the following command:
rm -rf /opt/vgwgs45

To uninstall the symbolic links created by the vglinks script during
installation, do the following steps:
1. Log in to your Solaris machine as user root or run su to become root.
2. Change your current working directory to /opt/vgwgs45.
3. Run the following vglinks script and follow the on-screen directions:
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./vglinks -r

or, to remove existing links without confirmation (to force deletion):
./vglinks -r -f
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Part 5. Appendixes
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Appendix A. Environment variable values

This appendix contains a complete list of environment variables for VisualAge
Generator.

You can set a value for the following environment variables. Many of the
environment variables have default values.

BTRINTF
Defines the home directory of the File Manager for CICS for OS/2.

Example
SET BTRINTF=/H:C:\CICS300\RUNTIME

CICSCOBCOPY
Specifies the directories containing COBOL copybooks, such as
C:\VGSVR45\COPYBOOK and C:\SQLLIB.

This environment variable is also used by the VisualAge Generator
templates in the COB2 –I option. This forces IBM VisualAge for
COBOL for OS/2 to use this variable to search for copy files.

If your generated programs use SQL, the SQL directory must be
included on the list of directories specified by the environment
variable CICSCOBCOPY.

Example:
SET CICSCOBCOPY=C:\VGSVR45;C:\SQLLIB

CICSRGRP
Specifies a list of CICS program resource groups that CICS for OS/2
uses at startup. By setting it, you may specify which CICS groups are
loaded by CICS for OS/2. If it is not set, all CICS groups will be
loaded.

Note: If the CICSRGRP environment variable is set, the FAASYS and
VGSVR45 groups must be included.

Example:
SET CICSRGRP=FAASYS,VGSVR45,APPGRP1

CICSCOBOL
Specifies which COBOL to use for compiling transactions.

Example:
SET CICSCOBOL=IBM
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CICSRD
Identifies the path and name of the CICS for OS/2 tables file
(FAACTFTB.BTR).

Example:
SET CICSRD=C:\CICS300\RUNTIME\DATA\FAACTFTB.BTR

CICSWRK
Specifies the list of directories CICS for OS/2 will use when searching
for run-time and program dynamic link libraries. This is a CICS for
OS/2 environment variable. It has the same format as the PATH
environment variable.

So that CICS for OS/2 can access VisualAge Generator generated
programs, CICSWRK must contain the directories which contain any
DLLs produced by VisualAge Generator preparation. This can be done
by adding these directories to CICSWRK, or by copying the program
DLLs to a directory already in CICSWRK.

COBPATH
Specifies the directory path to be used by the COBOL run-time
environment to locate dynamically accessed programs.

Example:
SET COBPATH=C:\IBMCOBOL\DLL;C:\VGSVR45\DLL;

CSODIR
Specifies the directory where the CSO.INI file is located. By default,
this location is the root directory where VisualAge Generator
Common Services is installed for OS/2 or Windows environments, or
the root directory where VisualAge Generator Server is installed for
AIX, HP-UX, and Solaris environments.

CSOTIMEOUT
Specifies the length of time in seconds after which a time-out error
occurs if the server does not respond to the client. The default value is
30.

CSOTROPT
Specifies the level of trace information collected for calls to
client/server programs and database connections. Trace information is
written to the file named in the CSOTROPT variable. The valid values
are:

0 Only errors are traced. 0 is the default.

1 Only errors are traced.

2 All client/server calls and database connections are traced.

CSOTROUT
Specifies the output file for trace information collected for calls to
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client/server programs and database connections. Level of
information is controlled by the CSOTROPT variable.

The default value is CSOTRACE.OUT.

DB2INSTANCE
Specifies the default instance name.

Example
export DB2INSTANCE=db2a

where db2a is the login name of the instance owner. For more
information on the DB2INSTANCE environment variable, refer to the
installation manual for DB2 for AIX, DB2 for HP-UX, or DB2 for
Solaris.

DLITROPT
DLITROPT specifies DL/I tracing options, which are used during
remote DL/I access when the middleware is provided by VisualAge.
This environment variable is used on Windows NT and OS/2 and can
take either of two values:

0 Only information on DL/I errors is retained in a file identified
in environment variable DLITROUT. 0 is the default.

1 Information on all DL/I activity is retained in that file.

Example:
SET DLITROPT=1

DLITROUT
DLITROUT specifies the file that receives DL/I trace information
during remote DL/I access when the middleware is provided by
VisualAge. If the value is blank or the environment variable
DLITROUT is not present, VisualAge writes trace information to file
VAGRMDLI.OUT. This environment variable is used on Windows NT
and OS/2.

If you do a typical install of VisualAge for Java, the file is in directory
C:\IBMJava\rmtDli; the equivalent directory for VisualAge Smalltalk
is C:\Program Files\VAST\rmtDli (on Windows NT) and
C:\VAST\rmtDli (on OS/2).

Example:
SET DLITROUT=C:\IBMJava\rmtDli

DPATH
Specifies the directories to search for CSO message tables and
conversion tables on OS/2, AIX, HP-UX, and Solaris. DPATH should
contain the following product directories:
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OS/2 C:\VGSVR45

AIX /usr/lpp/vgwgs45:/usr/lpp/vgwgs45/lib

HP-UX /opt/vgwgs45:/opt/vgwgs45/lib

Solaris /opt/vgwgs45:/opt/vgwgs45/lib

Note: On Windows NT, the PATH environment variable is searched
for CSO message tables and conversion tables.

ELAPATH
Specifies the product directory, such as C:\VGSVR45, where
VisualAge Generator Server is installed.

The default location is C:\VGSVR45. This is not a list of directories.
Specify only one directory and do not end the statement with a
semicolon (;).

Example:
SET ELAPATH=C:\VGSVR45

ELARTRDB_tttt
Specifies the name of the relational database to be connected to a
specific generated program.

The tttt specifies the CICS for OS/2 transaction ID for the transaction
requiring access to the relational database.

Note: For transaction names of less than 4 characters, trailing blanks
should not be included. For example, if you want to specify a
database name for a transaction with the transaction name
ABC, set the following:
SET ELARTRDB_ABC=ALPHADB

This environment variable is optional when running the Start CICS
OS/2 with VisualAge Generator Server Run-time Support program,
ELARUNC.CMD.

If this environment variable does not have a value for the transaction
being run, a default database will is used.

Example:
SET ELARTRDB_MYAP=MYDATA

EZERGRGL_xxx
This environment variable specifies the default date edit mask for the
long version of the Gregorian date.

The default date edit mask is derived from the system date format.
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This environment variable is used only for VisualAge Generator
Server. VisualAge Generator Developer uses the Long Gregorian value
on the Date Formats VAGen Options or Preferences page.

Example

In the following example, the default date edit mask is set to
YYYY-MM-DD.

SET EZERGRGL_ENU=YYYY-MM-DD

The long version of the Gregorian mask must contain the following
parts in any order:

YYYY 4-digit year

MM 2-digit month

DD 2-digit day of month

The mask parts must be separated by any single-byte nonnumeric
character except D, M, or Y.

For example, a mask of YYYY/MM/DD is used to display the date
2000/02/05, February 5, 2000.

The xxx specifies the NLS language identifier. See EZERNLS for the
valid languages.

EZERGRGS_xxx
This environment variable specifies the default date edit mask for the
short version of a Gregorian date.

The default date edit mask is derived from the system date format.

This environment variable is used only for VisualAge Generator
Server. VisualAge Generator Developer uses the Short Gregorian value
on the Date Formats VAGen Options or Preferences page.

Example

In the following example, the default date edit mask is set to
YY-MM-DD.

SET EZERGRGS_ENU=YY-MM-DD

The short version of the Gregorian mask must contain the following
parts in any order:

YY 2-digit year

MM 2-digit month

DD 2-digit day of month
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The mask parts must be separated by any single-byte nonnumeric
character except D, M, or Y.

For example, a mask of YY/MM/DD is used to display the date
00/02/05, February 5, 2000.

The xxx specifies the NLS language identifier. See EZERNLS for the
valid languages.

EZERJULL_xxx
This environment variable specifies the default date edit mask for the
long version of a day-of-year date.

The default date edit mask is derived from the system date format.

This environment variable is used only for VisualAge Generator
Server. VisualAge Generator Developer uses the Long Julian value on
the Date Formats VAGen Options or Preferences page.

Example

In the following example, the default date edit mask is set to
YYYY-DDD:
SET EZERJULL_ENU=YYYY-DDD

The long version of the day-of-year mask must contain the following
parts in any order:

YYYY 4-digit year

DDD 3-digit day of year

The mask parts must be separated by any single-byte nonnumeric
character except D or Y.

For example, a mask of DDD-YYYY can be used to display the date
036-2000, which is February 5, 2000.

The xxx specifies the NLS language identifier. See EZERNLS for the
valid languages.

EZERJULS_xxx
This environment variable specifies the default date edit mask for the
short version of a day-of-year date.

The default date edit mask is derived from the system date format.

This environment variable is used only for VisualAge Generator
Server. VisualAge Generator Developer uses the Short Julian value on
the Date Formats VAGen Options or Preferences page.
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Example

In the following example, the default date edit mask is set to
YY-DDD. Dates are displayed in the form YY-DDD.
SET EZERJULS_ENU=YY-DDD

The short version of the day-of-year mask must contain the following
parts in any order:

YY 2-digit year

DDD 3-digit day of year

The mask parts must be separated by any single-byte nonnumeric
character except D or Y.

For example, a mask of DDD-YY can be used to display the date
036-00, which is February 5, 2000.

The xxx specifies the NLS language identifier. See EZERNLS for the
valid languages.

EZERNLS
This environment variable specifies the default national language code
for VisualAge Generator Server.

This environment variable is only used for VisualAge Generator
Server. VisualAge Generator Developer uses the HPTRULES.NLS file.

See “NLS customization” on page 107 for more information.

The NLS language identifiers for VisualAge Generator Server are
shown below.

Code Language
CHS Simplified Chinese
CHT Traditional Chinese5

DES Swiss German
DEU German
ENU US English
ESP Spanish
FRA French5

ITA Italian5

JPN Japanese
KOR Korean
PTB Brazilian Portuguese

5. French, Italian, and traditional Chinese are not available in the OS/2 and CICS for OS/2 environments.
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You can change the value of EZERNLS.

The NLS value is determined as follows:
1. If the /NLS option is specified, the language specified by the

/NLS option is used.
If the language specified for /NLS is not valid, a message is issued
with a return code of 16.

2. If a value is not specified for /NLS, the EZERNLS environment
variable is checked.
If the value specified for EZERNLS is not valid, the following
occurs:
v A return code of 65283 is issued
v Messages cannot be displayed

3. If a value is not specified for either the /NLS option or the
EZERNLS environment variable, the first language in the default
NLS file, specified by the VAST_NLS environment variable, is
used.

Example

In the following example, for OS/2, the EZERNLS environment
variable is set to JPN (Japanese):
SET EZERNLS=JPN

For AIX, if EZERNLS is not specified in your .profile file, the /nls
parameter is required when you run the program, for example:
fcwrun progname /nls=enu

EZERSQLDATE
This environment variable specifies a 3-character value identifying the
SQL date and time format for DB2.

The valid values for SQL date and time formats are as follows:

DEF Format associated with the current country code

EUR IBM standard format for Europe

ISO Format of the International Organization for Standardization

JIS Format of the Japanese Industrial Standard

LOC Format in local form associated with the current country code

USA IBM standard format for the United States

The default SQL date and time format is DEF.
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This environment variable is only used for VisualAge Generator
Server. VisualAge Generator Developer uses the sqlDateTime key in the
HPT.INI file. Refer to the IBM DB2 Command Reference for more
information on the DateTime parameter for the BIND command.

Example

In the following example, the SQL date and time format is set to the
International Organization of Standards format:
SET EZERSQLDATE=ISO

EZERSQLDB
This environment variable specifies a default database name when
accessing relational database tables.

This environment variable is only used for VisualAge Generator
Server. VisualAge Generator Developer uses the sqlDefaultDatabase key
in the HPT.INI file. See the VisualAge Generator Installation Guide for
more information.

You can override the EZERSQLDB value using the /SQLDB option on
the GENERATE or PREPARE subcommands.

VisualAge Generator Server for OS/2

This environment variable is optional when running programs under
OS/2 environment. The environment variable
FCWDBNAME_progname overrides EZERSQLDB for the VisualAge
Generator program (progname) specified. If neither EZERSQLDB nor
FCWDBNAME_progname is set during run time, the default value
used is the DB2 environment variable DB2DBDFT. VisualAge
Generator environment variables for OS/2 are normally set in the
config.sys file.

VisualAge Generator Server for CICS OS/2

This environment variable is optional when running programs under
CICS OS/2 environment. The environment variable ELARTRDB_tranid
overrides EZERSQLDB for the VisualAge Generator transaction
(tranid) specified. If neither EZERSQLDB nor ELARTRDB_tranid is set
during run time, no default is provided by VisualAge Generator
Server. VisualAge Generator environment variables for CICS OS/2 are
normally set in the ELAENV.CMD file.

VisualAge Generator Server for AIX

This environment variable is optional when running programs in the
AIX environment. The environment variable FCWDBNAME_progname
overrides EZERSQLDB for the VisualAge Generator program
(progname) specified. If neither EZERSQLDB nor
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FCWDBNAME_progname is set during run time, the default value
used is the DB2 environment variable DB2DBDFT. VisualAge
Generator environment variables for AIX are normally set in a user’s
.profile file.

VisualAge Generator Server for CICS on AIX

This environment variable is optional when running programs in the
AIX environment. The environment variable FCWTRDB_tranid
overrides EZERSQLDB for the VisualAge Generator transaction
(tranid) specified. If neither EZERSQLDB nor FCWTRDB_tranid is set
during run time, the default value used is the DB2 environment
variable DB2DBDFT. VisualAge Generator environment variables for
CICS on AIX should be set in the CICS environment file.

VisualAge Generator Server for Solaris

This environment variable is optional when running programs in the
Solaris environment. The environment variable
FCWDBNAME_progname overrides EZERSQLDB for the VisualAge
Generator program (progname) specified. If neither EZERSQLDB nor
FCWDBNAME_progname is set during run time, the default value
used is the DB2 environment variable DB2DBDFT. VisualAge
Generator environment variables for Solaris are normally set in a
user’s .profile file.

VisualAge Generator Server for CICS on Solaris

This environment variable is optional when running programs in the
Solaris environment. The environment variable FCWTRDB_tranid
overrides EZERSQLDB for the VisualAge Generator transaction
(tranid) specified. If neither EZERSQLDB nor FCWTRDB_tranid is set
during run time, the default value used is the DB2 environment
variable DB2DBDFT. VisualAge Generator environment variables for
CICS on Solaris should be set in the CICS environment file.

VisualAge Generator Server for Windows NT

This environment variable is optional when running programs in the
Windows NT environment. The environment variable
FCWDBNAME_progname overrides EZERSQLDB for the VisualAge
Generator program (progname) specified.. If neither EZERSQLDB nor
FCWDBNAME_progname is set during run time, the default value
used is the DB2 environment variable DB2DBDFT. VisualAge
Generator environment variable for Windows NT are normally set in
the Control Panel.

VisualAge Generator Server for CICS for Windows NT

This environment variable is optional when running programs in the
CICS for Windows NT environment. The environment variable
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FCWTRDB_tranid overrides EZERSQLDB for the VisualAge Generator
transaction (transid) specified. If EZERSQLDB or FCWTRDB_tranid is
set during run time, the default value used is the DB2 environment
variable DB2DBDFT. VisualAge Generator environment variables for
CICS for Windows NT should be set in the CICS environment file.

VisualAge Generator Server for HP-UX

This environment variable is optional when running programs in the
HP-UX environment. The environment variable
FCWDBNAME_progname overrides EZERSQLDB for the VisualAge
Generator program (progname) specified. If neither EZERSQLDB nor
FCWDBNAME_progname is set during run time, the default value
used is the DB2 environment variable DB2DBDFT. VisualAge
Generator environment variables for HP-UX are normally set in a
user’s .profile file.

EZERSQLM1
Specifies the options to start a database again if it was left in an
uncommitted state.

The valid values are as follows:

YES Start the database again

NO Do not start the database again

The default value is YES.

This environment variable is optional when running the Start CICS
OS/2 with VisualAge Generator Server Run-time Support program,
ELARUNC.CMD. This environment variable is also used when
generated programs run.

Example
SET EZERSQLM1=NO

EZERSQLM2
Specifies whether VisualAge Generator Server runs the BIND utility to
produce an access plan for a generated COBOL program if the access
plan is not available.

When a generated program that accesses SQL data begins running,
VisualAge Generator Server verifies whether the SQL access plan is
available. If it is not, and if the value of EZERSQLM2 is YES, the
BIND utility runs to build the access plan.

The valid values are as follows:

YES Run the BIND utility if needed.
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NO Do not run the BIND utility.

The default value is YES.

This environment variable is optional when running the Start CICS
OS/2 with VisualAge Generator Server Run-time Support program,
ELARUNC.CMD. This environment variable is used when generated
programs run.

The .BND file for the program, which is created when the program is
prepared, must be located in the same directory as the program.

Example
SET EZERSQLM2=NO

EZERSQLMF
Specifies where messages from the BIND utility are directed if
EZERSQLM2 has the value of YES.

The messages from the BIND utility are written to the OS/2 device or
file as specified by the value of environment variable EZERSQLMF. If
you specify a file name, the location of the file defaults to the CICS
for OS/2 product directory. This CICS for OS/2 executable directory is
the directory in which CICS for OS/2 is running.

Messages do not come directly to the screen. Some valid values are as
follows:
v Any file name
v LPT1
v NUL
v PRN

The default value is NUL, which causes the messages to be discarded.

This environment variable is optional when running the Start CICS
OS/2 with VisualAge Generator Server Run-time Support program,
ELARUNC.CMD.

Example
SET EZERSQLMF=LPT2

EZERSQLUS
Specifies the access mode for a database when the START USING
DATABASE service runs for a generated COBOL program.

The valid values are as follows:
S Use the database in SHARED mode
X Use the database in EXCLUSIVE mode.
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The default value is S.

This environment variable is used when generated programs run.

This environment variable is optional when running the Start CICS
OS/2 with VisualAge Generator Server Run-time Support program,
ELARUNC.CMD.

Example
SET EZERSQLUS=X

FCWCOMP
Specifies the C++ compiler used to compile generated programs. It is
used for VisualAge Generator Server for Windows NT when you are
preparing a program. It is not used at run time.

The following values are valid:
MSVC Microsoft Visual C++ Version 5 or 6
VA36 IBM VisualAge C++ Version 3.6

FCWDB2DIR
Specifies the directory where Database 2 for AIX, Database 2 for
HP-UX, or Database 2 for Solaris is installed.

Example for AIX
export FCWDB2DIR=/usr/lpp/db2_01_01_0000

Example for HP-UX or Solaris
export FCWDB2DIR=/opt/IBMdb2/v5.0

FCWDBNAME_progname
Specifies the name of the relational database to be used for running a
specific program under OS/2, AIX, Windows NT, HP-UX, or Solaris.
This environment variable allows the database name to be specified
on a program basis. If FCWDBNAME_progname is not specified,
EZERSQLDB is used. If EZERSQLDB is not specified, the DB2
environment variable, DB2DBDFT is used.

Example for OS/2 or Windows NT:
SET FCWDBNAME_MYAPP=MYDB

Example for AIX, HP-UX, or Solaris:
export FCWDBNAME_DBSERVE=mydb

FCWDBNOOP
Specifies whether you want VisualAge Generator Server or CICS to
issue commits/rollbacks. If this environment variable is set, CICS will
issue syncpoints to control the unit of work. This environment
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variable is only valid in the CICS environments and must be specified
if the CICS region is configured with XA-enabled databases.

Example for AIX:
export FCWDBNOOP=yes

Example for Windows NT:
set FCWDBNOOP=yes

FCWDBPASSWORD
Specifies the password for connecting to a relational database on
OS/2, Windows NT, AIX, HP-UX, or Solaris.

Example
export FCWDBPASSWORD=abcdef

FCWDBUSER
Specifies the user ID for connecting to a relational database on OS/2,
Windows NT, AIX, HP-UX, or Solaris.

Example
export FCWDBUSER=mary

FCWDBVERSION
Specifies the version of the database software installed on the
Windows NT system. This environment variable is used when
preparing SQL programs for execution under Windows NT. It is also
used by the orasetup.exe utility when attempting to determine what
version of the VisualAge Generator Server for Windows NT Oracle
modules are being used.

The following values are valid when preparing Oracle SQL programs:

8 Oracle8 for Windows NT is installed on the Windows NT
system.

7 Oracle7 for Windows NT is installed on the Windows NT
system.

This environment variable is not used when preparing DB2 or ODBC
programs.

Example
SET FCWDBVERSION=8

FCWDPATH
Specifies the directories to search for tables and resource association
files.

Example for OS/2 or Windows NT:
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SET FCWDPATH=C:\VGSVR45

Example for AIX, HP-UX, or Solaris:
export FCWDPATH=/u/mary/genout

FCWFIODB
Specifies the name of the database to be used for CICS files when the
CICS region is configured to use DB2 as a file system instead of SFS.
For implicit connections, the databases accessed by the program are
determined by EZERSQLDB and FCWTRDB_tttt.

Example for AIX
export FCWFIODB=cicsdb

Example for Windows NT
set FCWFIODB=cicsdb

FCWLIBPATH
Specifies one or more directories to search for compiled programs and
map groups.

Example
export FCWLIBPATH=/u/mary/genout

FCWMAKE
Specifies the location of the makefile, FCWMAKE. This environment
variable is used when preparing programs for execution under OS/2
and Windows NT.

Example:
SET FCWMAKE=C:\VGSVR45

FCWRSC
Specifies the resource association file. The default resource association
file name is fcw.rsc.

Example for OS/2 or Windows NT:
SET FCWRSC=fcw.rsc

Example for AIX, HP-UX, or Solaris:
export FCWRSC=fcw.rsc

FCWOPT
Specifies run time options for Server. This environment variable is
used when executing programs under OS/2, AIX, Windows NT,
HP-UX, or Solaris. You can specify one or more of the following
options:

1 A map field with a date mask can be modified and left blank
without causing a date validation error.
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FCWTRDB_tranid
Specifies the name of the relational database to be used for running a
transaction under CICS. This environment variable allows the
database name to be specified on a transaction basis. If
FCWTRDB_tranid is not specified, EZERSQLDB is used. If
EZERSQLDB is not specified, the DB2 environment variable,
DB2DBDFT is used.

FCWTROPT
Specifies the Server trace option. This environment variable is used
when executing programs under OS/2, AIX, Windows NT, HP-UX,
and Solaris. You can specify one or more of the following options:

0 To turn the off trace

1 To trace entry or exit for program, process, or statement
groups

2 To trace CALL XFER DXFR statements

4 To trace SQL I/O

8 To trace File I/O

16 To trace System events

31 To turn all of the trace options on

Example
SET FCWTROPT=31

Note: If FCWTROPT is not specified, the trace is not produced.

FCWTROUT
Specifies the trace output file. This environment variable is used by
OS/2, AIX, Windows NT, HP-UX, and Solaris. The default trace
output file is FCWTRACE.OUT.

Example for OS/2 or Windows NT
SET FCWTROUT=myapp.out

Example for AIX, HP-UX, or Solaris
export FCWTROUT=myapp.out

INFORMIXDIR
Specifies the directory containing the VisualAge Generator software.
Required for ODBC on AIX, HP-UX, and Solaris.

Example for AIX
export INFORMIXDIR=/usr/lpp/vgwgs45/lib
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Example for HP-UX or Solaris
export INFORMIXDIR=/opt/vgwgs45/lib

MDLROOT
Specifies the directory where the VisualAge Generator Templates is
installed. This environment variable is used by OS/2 and
Windows NT.

Example for OS/2 or Windows NT
SET MDLROOT=c:\VAST

ORACLE_HOME
Specifies the directory containing the Oracle software. Required for
Oracle on AIX, HP-UX, and Solaris.

Example for AIX
export ORACLE_HOME=/usr/app/oracle/product/7.3.4

Example for HP-UX or Solaris
export ORACLE_HOME=/u01/app/oracle/product/7.3.4

RMTDLI_PARTNER_LU
Specifies the name of the partner LU alias used during remote DL/I
access when the middleware is provided by VisualAge. This
environment variable is used on Windows NT and OS/2.

Example:
SET RMTDLI_PARTNER_LU=ZZLU

RMTDLI_PARTNER_TP
Specifies the TP name of the remote DL/I server and is used during
remote DL/I access when the middleware is provided by VisualAge.
This environment variable is used on Windows NT and OS/2.

Example:
SET RMTDLI_PARTNER_TP=ZZTP

RMTDLI_SERVER_ENV
Specifies the fully qualified name of the local Server Environment File,
which is used during remote DL/I access when the middleware is
provided by VisualAge. The Server Environment File overrides dataset
names in the JCL that defines an IMS batch job; for details on that file,
see the User’s Guide. This environment variable is used on Windows
NT and OS/2.

Example:
SET RMTDLI_SERVER_ENV=C:\VAGEN\serven.txt
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Appendix B. National language support

This chapter describes information VisualAge Generator’s support for national
languages.

VisualAge Generator Developer national language support

VisualAge Generator Developer provides support for several national
languages. In this document, the lowercase xxx is used to specify a language
version identifier. Environment variables with the suffix xxx are language
dependent. The language version identifier is also used when starting
VisualAge Generator Developer with the optional /NLS parameter. Use the
following codes as valid substitutions for the lowercase xxx to denote a
language version of VisualAge Generator Developer:

Code Language
enu US English
jpn Japanese
kor Korean (available only with the Java-based version of VisualAge

Generator Developer)
ptb Brazilian Portuguese

NLS characters
Some files in VisualAge Generator are named according to the language
version. The file name is altered by one letter to indicate the language version.
This document uses a lowercase y to denote the language code for each
translated version of VisualAge Generator.

To specify a language version, substitute a code letter from the following list
for y:

Code Language
e US English
j Japanese
k Korean (available only with the Java-based version of VisualAge

Generator Developer)
p Brazilian Portuguese

NLS customization
VisualAge Generator Developer can be customized to suit your National
Language requirements by modifying the file HPTRULES.NLS. This file is in
the NLS subdirectory of the VisualAge installation directory. This file consists
of four sections:
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NLS rules
Customize Developer language suffix and special characters

DBCS rules
Further customize Developer for double byte locales

Generation rules
Customize specific generation options

Conversion rules
Customize conversion table names for the target generation
environments

The key in each section is the locale, which is formed by combining the
language and territory separated by a dash (-), for example english-us. Each
language and territory must be a valid value that could be reported by the
Locale class in VisualAge Smalltalk.

General file information
Blank lines and any lines beginning with an ″*″ in column 1 are ignored. Each
section begins with a :tag, where tag is replaced by a keyword for each
section. These tags must not be changed. Except where indicated as
acceptable, do not embed any blanks (spaces or other unprintable characters)
in the values specified. All invalid lines will be ignored. If no valid
information is available for a locale, default information (generally the same
as the english-us values) will be used.

This file should be maintained by the System Administrator and distributed to
individual developers.

NLS rules
This section begins with the tag :nlsrules and is used to specify the three
letter VisualAge Generator language suffix that represents the default target
NLS system for generation. See the TARGNLS generation option description in
the VisualAge Generator Generation Guide for more information. In addition, the
national characters, the not sign, and the alternate not sign are specified in
this section.

The national characters are valid for use in some VisualAge Generator part
names and default to $, #, and @ in English. The not sign and alternate not
sign specify the values that can be legally used in VisualAge Generator
language statements, for example IF A |= B.

Each line is this section must follow these rules. If a line does not follow these
rules it will be ignored:
v Exactly three blank-delimited words, including the key in single quotes
v The second column must be five characters long
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v The third column must be three characters long

As stated before, blanks cannot be embedded in the values, as this will result
in the line containing more than three space-character-delimited words. Thus
english-us is a legal key, but english - us will cause the line to be ignored.
Likewise, you cannot leave one of the national characters blank.

DBCS rules
This section begins with the tag :dbcsrules and is used to specify various
values that are required by VisualAge Generator. These values are all coded as
the hexadecimal ASCII code point values that correspond to the characters
indicated for the column. With the key in column 1, column 2 contains the
value of the DBCS space and column 3 the value for the DBCS asterisk (*) for
the locale indicated by the key.

Column 4 contains pairs of ASCII values that indicate the character ranges of
the DBCS English alphabetic uppercase letters. Column 5 contains the same,
but for the DBCS English alphabetic lowercase letters. These are required by
VisualAge Generator Developer to correctly fold the alphabetic part of DBCS
part names. The format, which contains no space characters, is as follows:
(nnnn,nnnn,nnnn,nnnn...)

There should always be an even number of values, and usually there will
only be one pair, for example (81C1,81E9).

Each line in this section must contain exactly five space-delimited words,
including the key in single quotes, or the line will be ignored.

Generation rules
This section begins with the tag :genrules and is used to specify default
values for the following generation options:

FTP_TRANSLATION_CMD_SBCS
FTP_TRANSLATION_CMD_DBCS
SEND_TRANSLATION_CMD_DBCS

The key, in single quotes, is specified on a line, followed by one to three lines
specifying the option values listed above. Anything else on the key line
invalidates the key and causes the lines to be ignored up to the next valid key
line.

Each value line must contain one of the above keywords as the first
space-delimited word on the line, otherwise it is ignored. The remainder of
the line contains the default value for the option and can contain anything,
including embedded blanks. Leading and trailing blanks will be removed.
Refer to the generation options in the VisualAge Generator Generation Guide for
more information on these commands.
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Omit any keyword lines that are not required for the locale and omit the key
if no values are required for any of the commands.

Conversion rules
This section begins with the tag :convrules and is used to specify the default
conversion table names used by VisualAge Generator when generating for
various environments. Most conversion tables required are shipped with the
product, but you may change the default table used for a locale/generation
environment to a different supplied table or to a custom table you have
created. See the VisualAge Generator Client/Server Communications Guide for
more information on creating tables.

The table format is as follows:

Column 2
default table name used when generating for EBCDIC environments,
like MVS, VSE, VM and OS/400.

Note: This table name is also used for converting DBCS part names to
EBCDIC when validating the part name and is the default table
name used by the Data File Conversion utility of VisualAge
Generator Developer.

Column 3
default table name used when generating for Windows environments,
like Windows 95, Windows 98, and Windows NT.

Column 4
default table name used when generating for OS/2 environments, like
OS/2 Warp and OS/2 CICS.

Column 5
default table name used when generating for UNIX environments like
AIX and HP-UX.

Each line in this section must contain exactly five space-delimited words,
including the key in single quotes, or the line will be ignored.

VisualAge Generator Server national language support

VisualAge Generator Server provides language version support. In this guide,
x and xxx signify a language version identifier.

Environment variables ending with xxx are language-dependent. The
language version identifier is also used when starting the conversion utility
for host data files with the /NLS. option.
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Table 13 shows the three-character (xxx) and one-character (y) NLS codes and
the language each represents.

Table 13. NLS codes

xxx y Language

chs c Simplified Chinese

cht t Traditional Chinese6

des w Swiss German

deu g German

enu e U.S. English

esp s Spanish

fra f French6

ita i Italian6

jpn j Japanese

kor k Korean

ptb p Brazilian-Portuguese

6. French, Italian, and traditional Chinese are not available in the OS/2 and CICS for OS/2 environments.
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Appendix C. Getting support

This appendix describes the ways you can get support for VisualAge
Generator. If you have a question or a problem, please first review
information contained in the VisualAge Generator product.

If you need to contact the IBM Support Center for assistance, you should be
at your workstation and have the following information available:
v VisualAge Generator version number.

To find the version number, on the VisualAge Generator window, from the
Help pull-down menu, select Product Information.

v What kind of hardware you are using
v What happened and what you were doing when the problem occurred
v The exact wording of any messages that were displayed.

Electronic support

An electronic forum is available to provide VisualAge Generator users the
capability to electronically access technical information, exchange messages
with other VisualAge Generator customers, and ask how-to questions.

The forum is accessible on the Internet at the following URL:
news://news.software.ibm.com/ibm.software.vagen

Additional technical information is available on the Internet. Please visit the
Personal Software Services Home Page at the following URL:
http://ps.software.ibm.com

Marketing highlights and features can be found at the following URL:
http://www.ibm.com/software/ad/visgen

Telephone support

The following sections contain useful phone numbers to use when you need
more information about VisualAge Generator.

Telephone support for North American customers
Support for VisualAge Generator is offered under the Personal Systems
Support Family
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The Personal Systems Support Family provides a menu of services, one of
which is Support Line. If you have purchased a Support Line contract you
may obtain usage/how-to and defect support via voice or electronically. Voice
support is available by calling 1-800-237-5511 and selecting the option for
OS/2, DOS, or IBM software running on these or other PC operating systems.

To obtain Technical Assistance (and access to other ″registered services″), you
must have purchased a Support Line contract and know your assigned
customer number and PIN (Personal Identification Number).

When you sign a Support Line contract, you are assigned two numbers. The
first is your customer number. The second is a Personal Identification Number
(PIN) for each designated contact. If you have purchased a Support Line
contract and do not know your customer number and PIN, or you want to
purchase a Support Line contract, contact the Personal Systems Support
Family Marketing Center at 1-800-IBM-4YOU.

Table 14 shows telephone numbers for IBM North American support.

Table 14. Telephone numbers for IBM North American support

Goal United States Canada

Answers to problems and
questions

1-800-237-5511 1-800-465-2222

Product information
packages

1-800-IBM-CALL
(1-800-426-2255)

1-800-IBM-CALL
(1-800-426- 2255)

VisualAge Generator
products

1-800-IBM-CALL
(1-800-426-2255)

1-800-IBM-CALL
(1-800-426- 2255)

Information on VisualAge
Generator education

1-800-IBM-TEACh
(1-800-426-8322)

1-800-IBM-TEACh
(1-800-426-8322)

For information on VisualAge Generator Consulting Services, go to
http://www.software.ibm.com/ad/vaws-services.

Telephone support outside North America
For information on Telephone Support, go to http://www.ibm.com/contact.

VisualAge Generator Consulting Services

The IBM Software Solutions Division development laboratory has established
the VisualAge Generator Consulting Services organization to provide a variety
of services to VisualAge Generator and Cross System Product current and
prospective customers. The consultants have multiple years of experience with
the VisualAge Generator and predecessor products, either as product
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developers on the products themselves or in working with a broad base of
customers, and is prepared to offer services worldwide.

The VisualAge Generator consulting team offers the following services:
v Set up and establish the local area network (LAN) infrastructure
v Establish the VisualAge Generator Developer and prerequisite products
v Establish the VisualAge Generator run-time environment
v Demonstrate the use of VisualAge Generator from program development to

execution (Proof of Concept)
v Migrate existing Cross System Product programs to the VisualAge

Generator and Cross System Product 4.1 environments.
v Provide specialized education on the VisualAge Generator products
v Provide mentoring service for developers as they increase their expertise

while working on real project tasks
v Design and/or develop specific client, server, or stand-alone programs

using either a graphical user interface (GUI) or text user interface (TUI)
v Develop and implement a code management strategy for the development

environment
v Provide MSL to ENVY migration services
v Analyze Cross System Product and VisualAge Generator source code for

potential year 2000 impacts

Customers can reduce their expenses and overall development cycle time by
using these services to accelerate their transition to the VisualAge Generator
products. Taking advantage of these services gives customers access to an
extensive technical skill base which can be used to either help them to grow
their own internal sills or to avoid the need to hire and train new personnel.

The VisualAge Generator Consulting Services team can be reached by calling
our consulting headquarters at 919-543-1326.

Maintaining VisualAge Generator

Product maintenance for VisualAge Generator is packaged as fixpaks.
Instructions for the fixpak installation are provided with each fixpak. You can
obtain information on the availability of fixpaks electronically through the
following media:

Internet
The VisualAge Generator fixpaks can be accessed using the following
URL:
ftp://ps.software.ibm.com/ps/products/visualagegen
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CompuServe
Forum information can be found by entering GO VISUAL from any !
prompt and selecting VAGEN.

If you do not have access to any of the above mechanisms, contact your local
IBM Support Center.
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Appendix D. Installing samples for VisualAge Generator
Developer on Smalltalk

The following sample applications are shipped as .DAT files with VisualAge
Generator Developer on Smalltalk. If you do a typical install, they are
installed in the samples subdirectory (for Windows,
C:\Program Files\VAST\samples and for OS/2, C:\VAST\samples). To use
the sample applications, you must import the .DAT file and load the
applications into your image. Other files needed to run and test the sample
applications are installed in the same subdirectory.

See “Importing and loading applications” on page 118 for additional
installation information or refer tothe section on importing and loading
samples in VisualAge Generator Getting Started for step-by-step instructions.

Note: If you are using VisualAge Generator Developer on Java, see
“Appendix E. Installing samples for VisualAge Generator Developer on
Java” on page 121.

A description of each application is provided in “Appendix F. Samples in
repositories” on page 123.

Table 15. Sample applications shipped with VisualAge Generator Developer on
Smalltalk

Repository Name Configuration Map Name Application Name

WEBS.DAT HptSampleWebApp /
HptSample3270MapApp

MQS.DAT HptSampleMQApp

ICPKGS.DAT VAGen Samples IC
Packaging

HptICSample4GLApp /
HptICSampleApp1 /
HptICSampleApp2 /
HptICSampleCommonPartsApp

EZEREMPS.DAT HptSampleEzerempParts

EZERSMPS.DAT HptSampleEzersmpParts

STAFFS.DAT HptSampleStaffParts

EZERMSGS.DAT HptSampleEzermsgParts

EZERPCBS.DAT HptSamplePcbParts

EZERADFS.DAT HptSampleEzerwadfParts
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Note: If your installation gives you access to a common repository (that is,
you are working from a client, not from a standalone install), you will
need two pieces of information to do the following tasks:
v The host name or IP address of the system where your repository

(server) is located
v A directory to which you have access that is defined to the server

You’ll then need to copy repository files to that directory and specify
the directory at the appropriate point in the following task.

Importing and loading applications

Most of the samples shipped with VisualAge Generator Developer on
Smalltalk are stored as applications. The IC Packaging sample, however, is
stored as a configuration map. See “Importing and loading configuration
maps” for instructions on accessing this sample.

To import and load an application:
1. From the VisualAge Organizer window, select the Applications menu,

then Import/Export→Import Applications

2. Specify the host name or IP address for the machine (for most clients this
will be the local host).

3. Specify the fully qualified path to the .DAT file you want to import and
click OK.

4. To load imported applications into your image, from the VisualAge
Organizer window, select the Applications menu, then Load→Available
Applications.

5. Select the application you want to load and the appropriate edition. Use
the >> push button to copy your selections into the Selected Editions list
box.

Note: You can load another application by repeating the previous two
steps.

6. When you have selected all of the applications you want to load, select
OK.

Importing and loading configuration maps

To import and load a configuration map:
1. From the System Transcript window, select Tools→Browse Configuration

Maps.
2. From the Configuration Maps Browser, select Name→Import
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3. Specify the host name or IP address of the server where the repository is
located.

4. Specify the repository you want to import from.
5. Select the configuration map and the version you want to import, move it

into the list at the right by selecting the >> button. Then select OK.
6. To load a configuration, from the Configuration Maps Browser, select the

configuration map from the Names panel and the edition from the
Editions and Versions panel.

7. From the Configuration Map Browser, select Editions→Load.

Importing database tables

The file SAMPTBLS.CMD is stored in the C:\Program Files\VAST\samples
directory for Windows (the C:\VAST\samples directory for OS/2). To import
all database tables required for the sample applications and the tutorial into a
database on your workstation, run the SAMPTBLS command.

Binding to a database

If you have not used this release of VisualAge Generator Developer with the
DB2 database before, VisualAge Generator prompts you to run the SQLBIND
command. Click Yes on the prompt window to run the command and bind to
a database, or select No and set database preferences. To set database
preferences:
1. From the VisualAge Organizer window, select Options→VAGen

Preferences.
2. Select the SQL option and type the appropriate preferences in the fields on

that page.
3. Click OK.
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Appendix E. Installing samples for VisualAge Generator
Developer on Java

The following samples are shipped as .DAT files with VisualAge Generator
Developer on Java. If you do a typical install, they are installed in the samples
subdirectory (c:\IBMVJava\IDE\program\samples). To use the samples, you
must import the .DAT file and load the project or package into your
workspace. Other files needed to run and test the samples are installed in the
same subdirectory.

See “Importing and loading projects and packages” for additional installation
information or refer to the section on importing and loading samples in
VisualAge Generator Getting Started for step-by-step instructions.

Note: If you are using VisualAge Generator Developer on Smalltalk, see
“Appendix D. Installing samples for VisualAge Generator Developer on
Smalltalk” on page 117.

Table 16. Samples shipped with VisualAge Generator Developer on Java

Repository Name Project Name Package Name

WEBJ.DAT VAGen Web Transaction
Sample

com.ibm.vgj.sample.map3270
com.ibm.vgj.sample.webmap

MQJ.DAT VAGen MQ Sample com.ibm.vgj.sample.mq

EZEREMPJ.DAT VAGen Employee Sample com.ibm.vgj.sample.ezeremp

EZERSMPJ.DAT VAGen Ezersmp Sample com.ibm.vgj.sample.ezersmp

STAFFJ.DAT VAGen Staff Sample com.ibm.vgj.sample.staff

EZERMSGJ.DAT VAGen Message
Conversion Sample

com.ibm.vgj.sample.ezermsg

EZERPCBJ.DAT VAGen PCB Sample com.ibm.vgj.sample.ezerpcb

EZERADFJ.DAT VAGen ADF Work
Database Sample

com.ibm.vgj.sample.ezerwadf

Importing and loading projects and packages

To import and load a project or package:
1. From the Workbench, select the File menu, then Import.
2. Select Repository.

© Copyright IBM Corp. 1992, 1999, 2000 121



3. Using the Import from another repository SmartGuide, specify the
location of the repository (.DAT file).

4. To import projects, select the Projects radio button, then select Details and
select the projects you want to load.

Note: You can also import individual packages by selecting the Packages
radio button, the Details button and then the packages you want to
import.

5. Select Finish to finish importing.
6. To load imported projects into your workspace, from the Projects tab

Selected menu, select Add→Project.

Note: You can load packages using these same instructions if you
selectAdd→Package. If you want to add packages instead of projects,
you must have an open edition of a project in your workspace to
add packages to.

7. Select Add projects from the repository and select the project to load.
8. Select the appropriate edition.
9. When you have finished selecting all the projects you want to load, select

Finish.

Additional files needed to generate and test the sample applications are also
stored on client workstations. If you did a typical install, these files are
located in the default directory C:\IBMVJava\IDE\program\samples.

Importing database tables

The file SAMPTBLS.CMD is stored in the
c:\IBMVJava\IDE\program\samples directory. To import all database tables
required for the samples and the tutorial into a database on your workstation,
run the SAMPTBLS command.

Binding to a database

If you have not used this release of VisualAge Generator Developer with this
DB2 database before, VisualAge Generator prompts you to run the SQLBIND
command. Click Yes on the prompt window to run the command and bind to
a database or, select No and set the database options. To set database options:
1. From the Workbench Workspace menu, select Open VAGen Parts

Browser.
2. Select the Window menu, then Options

3. Select the SQL and type the appropriate options in the fields on that page.
4. Click OK.
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Appendix F. Samples in repositories

Samples can be used to test your system setup. You should be able to
generate and run these application systems on the workstation or on the host.
The samples are listed in alphabetical order by repository name. File names in
the form *J.DAT file are for Java and *S.DAT are for Smalltalk.

Where appropriate, a configuration map or project name is shown. Many of
the samples are managed as applications on Smalltalk and therefore, will not
have a configuration map name corresponding to a project name. Many of the
samples that are available for Smalltalk show only the repository name and
the application name.

Repository Name on Java/Repository Name on Smalltalk
Project/Configuration Map Name

Package/Application Name(s)
Brief explanation of what the sample does.

EZEREMPJ.DAT / EZEREMPS.DAT
VAGen Employee Sample / No configuration map

com.ibm.vgj.sample.ezeremp / HptSampleEzerempParts
This sample is a simple employee database system. You can
use this example to verify that your system can properly
access DB2 data. The file EZEREMP.IXF contains a DB2 table
and data for use with this application.

EZERMSGJ.DAT / EZERMSGS.DAT
VAGen Message Conversion Sample / No configuration map

com.ibm.vgj.sample.ezermsg / HptSampleEzermsgParts
This sample is used on the host to convert user message files
to message table parts in external source format.

Note: Because this file includes some VAGen parts that have
the same names as parts in EZEREMP*.DAT, you
should unload the applications/packages you imported
from this file, before you load the one imported from
EZERMSG*.DAT.

EZERPCBJ.DAT / EZERPCBS.DAT
VAGen PCB Sample / No configuration map

com.ibm.vgj.sample.ezerpcb / HptSamplePcbParts
This sample contains examples of record definitions
corresponding to all PCB types.

© Copyright IBM Corp. 1992, 1999, 2000 123



EZERSMPJ.DAT / EZERSMPS.DAT
VAGen Ezersmp Sample / No configuration map

com.ibm.vgj.sample.ezersmp / HptSampleEzersmpParts
This sample contains examples showing how to develop
applications for basic business requirements. Applications for
accessing SQL databases, DL/I databases and data files, and
versions of these applications customized for the IMS
environment are included.

The following files contain DB2 tables and data for the EX00A
program. To use any of the tables, you must import them
using:

File Table name

INVENTRY.IXF INVENTORY

QUOTATNS.IXF QUOTATIONS

SECURITY.IXF SECURITY

SUPPLRS.IXF SUPPLIERS

The following files contain IMS program specification blocks,
database definitions, and data for the EX00AD program:
v SUPPQDBD.DBD—Database definition source file for the

SUPPQDB database
v SUPPINDX.DBD—Database definition source file for the

SUPPQDB database
v INVDB.DBD—Database definition source file for the

INVDB database
v INVINDX.DBD—Database definition source file for the

INVDB database
v EX99PS.PSB—Program specification block source file
v SUPPQDB.DTA—Data file for the SUPPQDB database
v INVDB.DTA—Data file for the INVDB database

The following files are data files for the EX00AV program.:
v INVNFILE.CSP
v QUOTFILE.CSP
v SUPFILEV.CSP
v EZERSMP.RAF (the resource association file)

These data files are in a format usable by the VisualAge
Generator test facility. To use these files with EX00AV, you
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must update the entries in the EZERSMP.RAF file with the
correct physical path of the first 3 files, if it has changed from
the default path.

To generate the sample applications, use the default
generation options file, create a Resource Association part
named EZERSMP, read the file EZERSMP.RSC into it and
specify it as the resource association file.

However, if you intend to generate and run the sample DL/I
program, EX00AD, on host environments other than IMS, you
need to remove ELAWORK from PSB EX99PS before
generation. Otherwise, message ELA00215P, PSB does not
match VisualAge Generator Developer PSB definition is
returned when the applications is run.

EZERADFJ.DAT / EZERADFS.DAT
VAGen ADF Work Database Sample / No configuration map

com.ibm.vgj.sample.ezerwadf / HptSampleEzerwadfParts
This sample contains examples of record definitions for the
ADF Work Database.

ICPKGS.DAT (Smalltalk only)
VAGen Samples IC Packaging

HptICSample4GLApp

HptICSampleApp1

HptICSampleApp2

HptICSampleCommonPartsApp

This sample is used to demonstrate automated IC packaging. For
more information on these samples, refer to the VisualAge Generator
User’s Guide.

MQJ.DAT / MQS.DAT
VAGen MQ Sample / No configuration map

com.ibm.vgj.sample.mq / HptSampleMQApp
This sample includes programs which demonstrate two ways
of accessing MQI, manual and automatic. The programs
which demonstrate how to call MQI manually are described
in the VisualAge Generator User’s Guide. The programs which
demonstrate how to call MQI automatically are described in
the file MQ.TXT, which is located in the same directory as this
DAT file.

Appendix F. Samples in repositories 125



STAFFJ.DAT / STAFFS.DAT
VAGen Staff Sample / No configuration map

com.ibm.vgj.sample.staff / HptSampleStaffParts
This sample application is a simple employee database system
with a graphical user interface that displays a list of
employees. The list includes user IDs, last names, salaries, and
commissions. The file STAFF.IXF contains a DB2 table and
data for use with this application.

This application/package includes programs that are used by
the stored procedure sample. See the VisualAge Generator
Design Guide for more detailed information on this sample.
The following files are included with this sample: STAFF.QMF
and STFPROC.SQL.

WEBJ.DAT / WEBS.DAT
VAGen Web Transaction Sample / No configuration map

com.ibm.vgj.sample.map3270 / HptSample3270MapApp

com.ibm.vgj.sample.webmap / HptSampleWebApp

This first sample is a set of text programs created using VisualAge
Generator templates. The programs list and update the EMPLOYEE
and DEPARTMENT tables in the DB2 sample database.

The second sample is the same set of programs modified to use web
user interface records (UI Records) instead of text maps. For
additional information on this sample, see WEB.TXT.

Associated files

This list provides a brief overview of the other files associated with the
VAGen samples that are located in the samples subdirectory.

CUSTOMER.IXF
This database table is associated with the VAGen tutorial in VisualAge
Generator Getting Started. You must install this database table in the
SAMPLE database using CUSTOMER as the table name to run the
SAMPLE program.

VBsamp.exe, PBsamp.exe
These samples show how to build Visual Basic and Power Builder
clients for VisualAge Generator server programs using VisualAge
Interspace. For more information on these samples, refer to the Visual
Age Generator Client/Server Communications Guide section on
calling server programs via VisualAge Interspace.
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